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CX-One CD-ROM contains a setup manual PDF file.
The Setup manual of CX-One is stored in the following file.
Diskl: CX-One_Manuals \ English\ CX-One Setup Manual W463-E1-01.pdf

Before using this product, you must read “Introduction” and “ Safety Cautions”.
Cautions and detailed explanation are available on Help and PDF Manual.
* Acrobat Reader 5.0 or later is required to read the PDF file.
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1. What is CX-One?

CX-One is an FA Integrated Tool Package that integrates Support Software for OMRON's PLC and other
Components.

To construct an FA System based mainly on PLC, traditionally it was necessary to purchase and install
individual Support Software compatible with each Unit, start the software individually, and then connect
to PLC and individual Components.

Installation of this FA Integrated Tool Package "CX-One" on a personal computer allows integrated
operation from setup of OMRON's CPU Bus Units and Special /0 Units (SIOU) and Components to
network start-up/monitoring and improving efficiency of PLC System start-up.

2. Features of CX-One

@ CX-One allows integrated management of Support Software for OMRON's PLC/Components.
* Installation on only one personal computer allows a user to handle Support Software for OMRON's
products.
* Only one licensing key is required to install all Support Software.
* It allows integrated management of one save location for files created by Support Software.

® Support Software dedicated to CPU Bus Units and Special I/O Units can be started on the 1/0 Table.

* The appropriate dedicated Support Software can be automatically started by specifying a
registered Unit in the I/O Table (Unit configuration table attached to a PLC). In addition, setup
information such as PLC model can be passed to the dedicated Support Software at start-up,
allowing easier switching between Support Software.

® The following functions are available by the introduction of the ID information file (CPS) for OMRON
Components.

» Setup of CPU Bus Units and Special I/O Units without manual setting and address recognition.
(Parameter and selection item names as well as available range of setup are automatically
displayed)

* CPU Bus Units and Special 1/0 Units setting on personal computer and data on actual PLC (CPU

Unit ) can be verified online, and unmatched item/readout data is displayed graphically.

* Unit configuration is displayed on the 1/0O Table based on Unit model.

* Device type on the network can be checked for its Unit model, allowing exact verification of

network configuration.

What is CPS?

CPS (Component and network Profile Sheet) is definition information of CS/CJ series Unit/Components in CX-One.
It is provided as a CPS file (XML format file).

CX-One recognizes CS/CJ series Unit by information in this CPS file. CPU Bus Units and Special I/O Units setting
is created based on this CPS file.




3. Integrated Simulation — New Function in Version 2.0

Integrated Simulation Overview:

Integrated Simulation is a function of CX-One (version 2.0 or higher) that
simultaneously tests interoperability between the ladder program and PT
(touch panel) and checks screen operation on the computer.

Earlier Versions:
Operation checks had to be performed separately on the ladder program and PT (touch panel)
screens. In addition, the program had to be downloaded to the devices.

Using Integrated Simulation:
Provides an interoperability check between the ladder program and
touch panel screens.

W Operation can be verified before actual devices such as the PLC and PT (touch panel) are
installed and wired, so software quality can be improved in the design stage.

W Time can be saved by eliminating the tasks up to downloading the screen data from the
computer to the PT.

W The operation of both the PLC and PT (touch panel) can be verified simultaneously in the
computer, which greatly reduces the time required for debugging and equipment downtime
during improvements.

Simulation of the PLC — PT (touch panel) system can be started easily,
with one click of an icon.

Ladder program Touch panel screen
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Linked and simulation started.



Integrated Simulation Procedure

Use the following procedure to execute an integrated simulation of the ladder program and PT
(touch panel) screen. For details, refer to the CX-Designer Operation Manual (V088).

Create the screen data in the CX-Designer.

Click the E Icon or select Tools — Integrated Simulation. The PLC-PT Integrated Simulation
Dialog Box will be displayed.

PLG-PT Inteerated Simulation

[ =1
File Names [ Browse

Select a host to execute using the simulator, and a GR=-Programmer project file. The other

hosts run in normal test made.

Click the Browse Button and select the desired ladder program (CXP) file.

Click the Start Button. The PLC-PT Integrated Simulation will start automatically.

The test window will be displayed.

The Test Tool Window will list all of the communications addresses being used in the displayed
screen. For example, when “Host SERIAL A” is connected to the CX-Simulator, the CX-
Simulator value is reflected in the SERIAL A communications address. (The values can also be
changed.)

D EM O NSB View(?  Optionsf0)  ToolD)
Display Tvpe IDEcimaI—Signed 'I
Bitmap
Host Type Address Type/Number Value :I
‘ r a1 = Al =] all =
- SERIALA CHANMWEL  |DMOOO01 1]
PLOAT ‘ viDE SERIALA |E0OL O0000.10 0
. SERIALA CHAMNMEL  |DMO0000 123
SERIALA BOOL 00000.01
DeviceNet Multi SERIALA BOOL 0000002 1
Status Language SERIALA BOQ|
| Test Tool I—

Smart Active Reaut iful

Parts Parts

Test Window




4. CX-One Component Checklist

CX-One consists of the following items. Check if they are included in the package.
® CX-One Components

Setup Disk (CD-ROM)

3 disks

CX-One Introduction Guide (this document No.R145)

Printed document and

CX-Programmer Introduction Guide (N0.R132)

PDF data on CD-ROM

CX-Designer Introduction Guide (No.V089)

Function Block Introduction Guide (No.R144)

CX-One Setup Manual (No.W463)

PDF data on CD-ROM

CX-Programmer Operation Manual (No.W446)

(Only major manuals

CX-Programmer Operation Manual, Function Block (No.W447)

listed.)

CX-Integrator Operation Manual (No. W464)

CX-Simulator Operation Manual (No. W366)

CX-Designer Users Manual (No.V088)

CX-Motion-NCF Operation Manual (No. W436)

CX-Motion-MCH Operation Manual (No. W448)

CX-Position Operation Manual (No. W433)

CX-Drive Operation Manual (No. W453)

CX-Protocol Operation Manual (No.W344)

CX-Process Tool Operation Manual (No.W372)

CX-Profibus Operation Manual (No.W05E)

Face Plate Auto-Builder for NS Operation Manual (No.W418)

OMRON FB Library Reference Manual (No. W442)

Smart Active Parts Library Reference Manual (*)

CX-Thermo Operation Manual

Online help only

TrajeXia Manual

Software License Agreement/User Registration Card

* PDF Manuals are provided for each Unit.

-\

cx-Che

FA Integrated Tool Package
CX-One Introduction Guide

The license number is
printed on the cover.

® CX-One Software List

User Registration Ca

rd

[—

Model number, license number,
and number of licenses are
printed on the card.

Product Model Installable peripheral tool Included data
CX-One CXONE-ALO1C-EV2 - CX-Programmer Ver.7 - OMRON FB
Ver.2 CXONE-ALO1D-EV2 - gi-lsmeglrator xer.i - ir;?grt Active Parts (SAP)
) - CX-Simulator er. -
(for 1 license) - CX-Designer Ver.2 - Manual (PDF)
CXONE-ALO3C-EV2 _ CX-Motion Ver.2
CXONE-ALO3D-EVZ | . cx-Motion-NCF Ver.1
(for 3 licenses) - CX-Motion-MCH Ver.2
CXONE-AL10C-EV2 - CX-Position Ver.2
CXONE-AL10D-Ev2 | - CX-Drive Ver.1
(or0tcenses) |- SXPranal vk
CXONE-AL30C-EV2 - CX-Profibus Ver.1
CXONE-AL30D-EV2 | - Face plate Auto-Builder for NS Ver.3
(for 30 licenses) - CX-Thermo Ver.3
CXONE-AL50C-EV2 - CX-FLnet Ver.1
CXONE-ALSOD-EV2 | - ?Wi_tCQ_BOX Utility Ver.1
for 50 licenses - lrajexia ver.2
( ) - CX-Sensor Ver.1




5. CX-One Installation Procedure

Before installing the CX-One, you must:

e Terminate all Windows programs

* Uninstall previous versions of Support Software (such as CX-Programmer) if already

installed.

* Installation takes about 10 to 40 minutes depending on your personal computer. (10
minutes for a personal computer with CPU: Celeron 2.2GHz, main memory: 512MB, and

CD-ROM drive: 48x)

* To change/modify/delete CX-One after installation, refer to the PDF manual “CX-One
Setup Manual”, Chapter 2 "Installation and Uninstallation”.

Installing CX-One

In case of the installing procedure by CD-ROM:

Insert CX-One installation disk 1 (CD-ROM) into your personal computer's CD-ROM drive.
[Choose Setup Language] dialog box is displayed. By default the OS language installed on
your personal computer is automatically selected.

Check if the language is appropriate, then click the [OK] button.

Choose Setup Language:

@ Select the language for thiz installation from the cholces belaw,
=

English [IUnited St:

Click [OK]

x|

Version 2.0

QMRON Corporat

International copyrigh

OmRON

rotected by U.5. and

as described in the About box.

Uninstall older version of tools such as PLC Tools (PLC System setting and 1/O Table),
CX-Server, and CX-Programmer if they have been installed.

Confirm uninstallation [ =]
& C¥-Programmer is already installed on vour computer,
Do you wish bo uninstall Ci-Programmer?

Click [2K] ta start the uninstaller.
IF wou do not want to uninstal, click [Cancel].

Always click [OK]

Uninstalling CX-Programmer

CX-Server is already installed on your computer

A

=
An older version of Cx-Server Yer 2,2,1.25 has been found,
To continue the installation of CX-Server Yer 2.3.0.13, the older version must be uninstalled.

Would you like to uninstall>

Click [OF] to continue or [Cancel] ko abart the installation of CX-One.

Cancel

Uninstalling CX-Server



CX-One setup wizard starts.
|

‘Welcome to the InstallShield Wizard for CX-One

The InstallShield® ‘wizard will install Cx-0ne on wour
computer. To continue, click Mext.

C||Ck[NeXt] ©000000000000000000000000000000000 [ IWI’ Cancel
———

The [License Agreement] dialog box is displayed.
Read the software license agreement carefully. If you agree with all items, select the [l accept
the terms of the license agreement] radio button and click the [Next] button.

x|

License Agreement .
Flease read the fallowing license agreement carefully, l "

IMPORTANT iI
By inztalling thiz package, vou agree to be bound by the following Software License
Agreement. |f you do not agree, please retumn the enclosed software ('S oftware"] without
inztalling this package to the shop where you bought the Software

The warranty service set forth in Section 7 of the Software License Agreement and any
infarmation on the Software and its revision and new version will not be provided to pou,
unless you register az an user of the Software by the enclosed user registration card,
Pleaze promptly fill in the card and send it to OMROM Corpaoration.

Select the radio button esecce | accept the terms of the license agreement Erirt |

+ | do mot accept the terms of the license agresment

IristallShield

Click [Next] (Eack- Cancel |

The [User information] dialog box is displayed.

C%-One - InstallShield Wizard x|

User information .
Please enter user information, l 3

Flease enter your name, company name, and license number, and then click [Mext].

User:
Enter [User]| [CompaHY], b
[License] (product serial Company:
number of CX-One) [omRoN

License:

Iristall5higld

Click [Nex] sl |




The [Installation Folder Selection] dialog box and [Setup Type] dialog box are displayed.

Select an installation
folder, then click [Next] Setup Type )

Select the setup type ta install. ‘M
Please select a setup type. By selecting [Custom], you
can individually select and
install Support Software
from the CD-ROM.

Select the radio button ceee..
[Complete]

All the applications in Cx-One will be installed.

" Cugtom :
.
@ Select which application pou want installed :
.
L]
.
rizard x|
. .
IrstalSHisld p wil inctal. E .‘M
CIICk [NeXt] | .<BSC% Cancel | want to instal, and dezelect the features ;:Du do nat want ta ingtall.
9, e
Description———————————————

‘rogrammer
Cx-Integrator Application software to create
_Positi and werify programs of
@ [t Posilon SYSMAC C3/C)-seris,
C-zeries, and Cyh1/CV-series
CPU Urits.

ace Plate Auto-Builder for MS

Cx-Protocol
fw#] C-Themno LI
993.39 MB of space required on the C diive
2711597 MB of space available on the C drive
Irzstal|Shield

el e MESEEEE 20l _.(‘,
click [Next] Bl Cancel |

The [Program Folder Selection], [Choose Destination Location of OMRON FB Library],
[Select Program Folder], and [Ready to Install the Program] dialog boxes are displayed.

O
Ready to Install the Program ‘ .
The wizard is ready to begin installation. ‘h |nsel’t CX'One DISkS 2 and 3

then click the [OK] button.
Click Install ta begin the installation.

IF pou want ko review or change any of pour installation settings, click Back. Click Cancel ta exit 5'

the wizard.
@ Please insert the disk: Cx-Cne Disk2
x|

@ Please insert the disk: CX-One Disk3
Cancel |

IrstallGhield

Click [Install] ........................... Cancel | @

CX-One - InstallShield Wizard

CX-One installation is starts.

InstallS hield Wizard Complete

Setup has finished installing C-One on your computer
A dialog box (right) is displayed.
Click the [Finish] button to finish
the installation wizard.

Installation is complete.

(When it is necessary to restart the
personal computer, a restart
confirmation dialog box appears.)

Click [Finish] o |

=

¥ Open Readme File

¥ Online registration




Online Registration

If the personal computer that the software has been installed on has an Internet connection,
you can proceed to online user registration.

After installation has been completed the [Online Registration] dialog box is displayed.

Online Registration

Do you want to register onling?

Exit |

I~ Donat dizplay thiz dislog again.

If you click the [Register] button, your Web browser connects to “OMRON'’s CX-One Web
site”.(*1) (*2)

*1: If you click the [Exit] button to cancel online registration, the [Online Registration] dialog box
is displayed every time the CX-One Support Software is started.

*2: If you do not have an Internet connection, or you do not want to register online, fill out and
send the user registration card that comes with the product.
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Example of PLC System Construction by CX-One

Workflow in This Chapter

This chapter describes an example of PLC System construction from design, online debugging on the actual
machine, and start-up/adjustment on-site as shown below.

CX-Programmer is used for ladder program creation and CPU Bus Units and Special /0 Units (SIOU) setting,
while CX-Designer is used for indicator screen generation. Also, a program simulation Support Software CX-

Simulator is used as a debugging example.

; 2 ; ; Setting ; ;
Starting CX Crea_tlng U_nlt CPU Bus Chegklng 110 Programming  Offline Debug Sav_lng
Programmer  Configuration Units/SIOU Assignment Project
s S
O
-
< e
S
< -
N
Design Online Debug of the Machine Start-Up/Adjustment On-Site
-7 [ !
,””’ l, \\\ “\
= ! N \
. Online . Unit
braeqt Comecton (RS g odfeaton  Parameter
! to PLC 9 Change
System Co nfi gu ration Unit Name Model Specifications
Power Unit CJ1W-PA202
CJ1W-AD081-V1 CPU Unit CJ1IM-CPU13 640 points, 20K steps
CX-One CJ1W-OC211 Unit No.= 21 e i
' DC Input Unit CJ1w-ID211
CJIW-NCF71 - ;
(CILW-MCHT1) Transistor Output Unit | CJ1IW-OC211
Connection Cable Unit No.= 2Hex

CS1W-CN226(2m)

CJ1W-DRM21
Unit No.= OHex
PLC1 Node Address= 01
CJ Series PLC|CJ1
T

— — CJ1W-SCU41-V1
o & Unit No.= 3Hex
hy E % E {15 (D
0 R 880
1 TN CIIW-CLK21-V1
CJ1w-ID211 Unit No.= 1Hex
4~ 20mA Node Address= 01

Termination Resistance

Connection Cable Setting= ON

XW22Z-200T(2m)

V 4

NS Series PT
NS8-TV00B-V1
System Version 6.0 or later

Sensor )
Servo Driver

R88D-WNO1L-ML2

4 analog inputs (Each point
selectable from 1~5V, 0~5V,
0~10V, -10~10V, 4~20mA)

Analog Input Unit CJ1W-AD081-V1

Position Control Unit CJ1IW-NCF71 Maximum control: 16 axis
Motion Control Unit CJIW-MCH71 Maximum control: 30 axis
DeviceNet Master Unit | CJIW-DRM21
ControllerLink Unit CJ1W-CLK21

Serial Communications

Unit CJ1W-SCU41-V1

Servo Driver R88D-WNO1L-ML2

NS Series PT NS8-TV00B-V1 8 inches TFT

Below is an example of a System that has CJ1M CPU
Unit with basic input/output Unit as well as analog input
Unit and NCF Unit to perform the following functions:

* 4~20mA input from a sensor

» Configure a servo driver connected to the NFC Unit.




Saving
a Project

; 3 ; ; Setting ;
Starting CX Creating Unit CPU BUs Checking 1/10

i : : ) Programming Offline Debug
DeSlgn Programmer Configuration Units/SIOU Assignment

Starting CX-Programmer

From the [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Programmer] > [CX-
Programmer] to start CX-Programmer. (Or select [All Programs] > [OMRON] > [CX-One] >

Starting CX-Programmer [CX-Programmer] > [CX-Programmer])

2c(ati%(ew||as B L

For e, pess Pl oo |

Creating a New Project Click this button to create a new CX-Programmer project.

oy PC ol

eR([ALSHa]L i [p 2E
—opagElk|[2een

File Miew PLC
Click D | . ..........¢ D E"" E | [
|-
I:j Dedicated Support Software for each Unit can be
started, succeeding communications settings from
CX-Programmer. You will not have to set up
communications using dedicated Support Software
if you set up communications here.
Dievice Marm General |
’7 ‘ ’—EPUT P ‘
i — Device Typpe — M
Click 3 and select esccos o olcg-]ﬁm]ﬁo eecccccoe ? Settings... Total Program Arca P
PLC model. m 5 ’V 10K [Step] <] I Readory
— Netwark Typ p
oolbus - 5 Expansion Memaopy®
IT . J"ﬂl ’7 l:lnma V I ™| Riead Orly ‘
i~ Comment . e
..' El ( ng' 1 FlResdony ‘
.'. Tine / Clack
@ .' j ’70 v [mstalled ‘
I:j o | _ié;cel | Hep | - Make Diefaul
=° un _p—
° Left-click ..' Cancel Help
Settings... ° ...
Cllckj and select CPU type
Select a PLC model from the following to use Function Blocks. Click [OK] and

CS1G-H, CS1H-H, CJ1G-H, CJ1H-H, CJIM determine CPU type.



Saving

. . Setting '
Creating Unit Checking I/0 Offline Debug

) . CPU Bus .
Configuration Units/SIOU Assignment

Starting CX- Programming

Programmer

a Project

Design

Creating Unit Configuration

When you select [Option] > [Consumption(mA)] from

Start the I/O Table/Unit setup function. )
the menu, you can check the width and current
izl consumption after PLC Unit configuration.
E{%gw%ject (Width indication is available only for SYSMAC CJ1)
. MewPLCL[CI1M] OFFli 0
Double-click [ I/O Table (=55 e h[l ] Offine :
and UnitSetup] | © | PLC IO Table - NewPLC1 =l 3 :
File Edit Wiew Options Help :
..... % CIiIM-CPU13 .
Inner Board °
@ ME-'ITIEIT";" < [0000] Main Rack :
o P . ;., [0000] Rack 01 .
E‘; Double-click [ 1/0 = T - =
Table and Unit Setup].
! Rack Power Supply Unit Consumptionma] — width(mm]
o 5 Section CRURack [ojrwepezosr -] 560 125.7
""" B Eno Rack 01 [Crnwpazosh x|
----- IF Function Blacks
Froject f

CHM-CPOTT [OTTrE Z

Right-click Empty Slot, select [Add Unit] and determine CPU type.
Then select [General Purpose Analog 1/0] from Unit selection window.

7 i PLC IO Table - NewPLC1 [_ O] x| Select Unit (<]

File Edit ‘iew Options Help 0
i
- CiM-ceui3 - Basic 1/0
H H Inner Board -
Right-click H i A Communications Adapter
9 e LI =4, [0000] Main Rack eneral Purpose Analog /0
Ceal . ¥ 00 [0000] Empky Slot o P Motion Controller
o ¢ 3 01 [0000] Empty Slat oo ® | = Position Controllsr
02 [0000] En . .-‘. - Sensor
Select [Add Unit] esscccocdee o D-j [gg.gg]ﬁ L. °° [#- Temperature Controller
05 (00000 € Lnit Comment o’ °
""" W 06[0000]E  SysmacEUSMaster L e°" >
----- § 07 [0000]E St
- 03 [0000]E - Unit Sefup oo ©
09 [0000]E Save Paganftiers
Click + symbol on s« darg: ponasIRueler © 20 ameters
analog |/O Start Special Application 3
Uk |+
Copy. Chrl+C
Paste e+
Delete Spec
Unit: Manufackuring information
Uit Errar Lag
Hat Swap

Cancel




i - F ; Setting : .
DeS|gn Starting CX Creating Unit CPU Bus Checking /04 b gramming  § Offline Debug saving
Programmer Configuration Units/SIOU Assignment a Project

Select Unit Type.

Select Unit

Uit

|»

Basic 1/0
Communications Adapter
[=- General Purpose &nalog 1/0
- CITWAD 041 [Analag Input Unit 4 points]

- C1Ww-Da041 [Analog Output Unit 4 points]
- CITW-DADBC[Analog Dutput Unit & paintsAcurent]
- CIW-D A0S [Analog Output Unit 8 points/voltage)
- CITW-MaD42[Analog 10 Unit Input: 4 pointed Output; 2
- G -PDC1 5] solated-type Analog Input Unit)
- 1w -PT515] zolated-type Thermocouple Input Unit]
- CIW-PTS16[ solated-type Resistance Themiometer [npr
- CITW-PTS51(Thermocouple Input unit]
- CITW-PTSE2[Platinum Resigtance Thermocouple [nput .—
[ Motion Contraller

[+ Position Contraller -
< | »

Spec

Click Ok | , Carcel |

Select Unit and Number.

Unit name: Analog Input Unit 8 points

Unit tppe:— CITW-ADO3TA

Lk

[ Uit 21

input range 0 - 95

Comment:

Enter Unit number.

Click ] 4 |............................... Cancel |

=




; L ; ; Setting ;
Starting CX Creating Unit CPU BUs Checking 1/10

3 Saving
DeSIg n Programmer Configuration Units/SIOU Assignment

Programming Offline Debug

a Project

The Analog Unit is registered to the 1/0O Table as shown below.
Set up the next analog Unit's parameter.
T { PLC IO Table - NewPLC1 =] E3
File Edit Wew Options Help

7 CI1M-cPUL3
|-y Inner Board
=& [0000] Main Rack

Double-click the analog _3’1 00 [0000] Empty Slot
Unlt r """ 2 nalog Input Unit & p Y ancy i i1, 9) ]

L e
----- 5 04 [0000] Empty Slat
----- 5 05 [0000] Empty Slat
----- 5 08 [0000] Empty Slat
----- 5 07 [0000] Empty Slat
----- 5 03 [0000] Empty Slat
----- 5 09 [0000] Empty Slat
[+, [0000] Rack 01

=

The Analog Unit Setup Screen is displayed.

CJ1W-AD081-Y1 [Edit Parameters]

[Cam-cru1a  [Offline 4

Displayed Parameter [

CPU Bus Units and Special I/O Units Setting

Item SetWalue Unit B

Input? Input signal use setting Disahle FunCtlon
Input Input | i Disahl oy . .
Inpui npi ignal e seting—[Disaiie Traditionally, initial CPU Bus Unit and Special
Inputd Input signal use setting Disahle . . .
Inpulf Inpt signal use seting Disabie I/O Unit settings were made by referring to
Inputf Input signal use setting Disable .
Inpul? Inpt signal use seting Disabie documentation to calculate DM address from
Inputd Input signal use setting Disable . . .
Input! Input range seting 0v the Unit number and entering a hexadecimal
Input? Input range setting +-10Y . .
Inputa Input range sefing T number. Now you can set it using the pull-down
Inputd Input range setting +-10Y . 5
InpulS Input range setiing “F0v menu in the CX-Programmer’s 1/0O Table.
Inputf Input range setting +-10Y LI s . .
S = Easy setup/transfer/verification operations are
= =l | available from the integrated parameter settings
screen as shown below, without recognizing
- .| addresses (this function uses CPS function of

TrersterlUritio FE] || TrenstetP o Ui | | Gompere| Fl CX-One pI'EVIOUS|y descrlbed)-
Set Defaults Cencel

Setting CPU Bus Units and Special I/0O Units

For example, specify input number designation and range.

C11W-ADOB1-¥1 [Edit Parameters] [<]
Unit parameter setting S 5 ‘
Itern nit - | . . .

Inputl Inputsignal use sefing Enabls Select [Enable] for input No.1 usage designation.
Input2 Input signal use setting 1
Inputs Input signal use setting Disable
Inputd Input signal use setting Disable -
Inputs Input signal use setting Disable
Inputt Input signal use setting Disahle

Input Input sional use setting Disahle

Inputd Input signal use setting [
O] (L0 S e Lovi-20ma x: | Select [1~5V/4~20mA] for input No.1 range setting. |

Input2 Input range setting

Input3 Input range setting +-104
Inputd Input range setting +-104
Inputs Input range setting +-104
Inputs Input range seting +H-10Y =]
Help
|| | <DefaulDisatle |
<Address>iw/ord:D22100, Bit1
<TypesList
TianstziUrit oD | | TianstetPCioUnt) | | Compee | et |

— Click the [OK] button.

Sat Defaults




Starting CX- Creating Unit Setting Checking 1/0

Saving a

DeSlgn Programmer Configuration CPU Bus Assignment Programming QUi E Il Project
Units/SIOU
NCF Unit and Servo Driver Connected to the NCF Unit Setup
As with Analog Unit registration, register the NCF Unit (CJIW-NCF71).
The NCF Unit resides within a position control Unit.
Nest, start CX-Motion-NCF using [Start with Settings Inherited].
When opening a stored project file after starting the dedicated tool, select [Start Only].
If [Start with Setting Inherited] is selected, a new project is created.
T PLC 10 Table - NewPLC1 [_ D[] [ untitled - Cx-Motion-NCF M= E
File Edit Wew Options Help File View PLC Unit Help
Right-click NCF Unit W oo EC IR
! li ﬁ'"gg%;g;;?;ﬂﬁt Slat ‘ 7 nntm\ Unit) (C1W-NCF71) [No mmment!>
@ w01 [0000] Empty Slot [Se— -
:: [221] J IDtnt)(O:cuDanw + 1){Unit ¢ 213 (Ouk: 1, In: 90 :
Point [Start Special L .
. . -7l 08 [0000] &1 it Comment o
Appllcatlon] I’I g; Egggg} E' SYSMAC BLS Master » N
@ ;l 02 [0000] & Unit Setup .'
1 4, [0000] Rack {  Save Parameters .
Load Parameters N
Start Special Application E o N
Click [Start with B N
. . Coy Ctrl+C L[]
Settings Inherited] s fth :
Delste .
Wit Manufcturing infermation fire=s] G Lol e N
Uit Error Log. o
Hat Swap 1M-CPUI3  [Offline 4 °

Displayed with NCF Unit registered.

Register a servo driver.
&S untitled - CX-Motion-NCF [_ 0]
Double-click NCF Unit Fle iew PLC Unt Help
D= a8 6

# PLC[C) Series PLC] Offine |8 CI11W-NCF71 Axis Map | x|
@ (i 1 ontrol j ent & Edt Onine Help

d
@ '. i . . "
D

lick
Clic il Double-click NCF Unit.

Click *1_

Press [F1] to display help. e 7

New Driver B

r— Driver hame
INew DCrriwer O

— Series — _ Select OMRON W series (with
|—W| communications function).

r— Diriver madel

[RESDWNITLHML? =] pefraiimomiotormn} Select R88D-WNO1L-ML2.
— Az Mo

IAxis m 'I

— Camment

[

i

4
Click -...-.. Cancel |
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Edit NCF Unit parameters.

:
[ACI1W-NCF71 Axis Map [x] e ]
Eile Edit Onlne Hel ——

o c = = = e [ Unit Parameters Bl
Double-click NCF Unit * bod B = Memory rea Sett | [~ Axis Operating Memory Area Designation
L W x| ¥ 5 ————
ommunications £
=-f ) s Selting >
s el
Input Mericry Arss [N Uit to PLE)
=[50 /—:‘/u
K I st CITNNNN o CITET3 /R sty Wi ko w511
H st HOON o H511 A svear A0 b A3ER
. . DM area: DDOD0D 1o 32767
Double-click NCF Unit. | EM st E 00000 to E2 32767 [-EM bgrk Mo ]
Each area acupies [the largest asis No.* 2§ words
.
1] 1 ® °
Dowrioad ld ! °
Set output relay area to

Infsize ClO100 and input relay
area to ClO500.

Jecceeccee Select [Axis 01].

o
Select = Urit Parameters Congy = Uit P B Setting As 01

Memorparea Sat | Encoder Type
Commfhicationgk |~ pgolyte Encoder & Inciemental Encoder

Auta Cammunications Setting

[Communications Setting]eee<-*

Transfer Ey.ae (ms) 1ms 2

s 01

0 D
Commurigations Cycle (Multiplier[3 D
Click ph =
.
osaf Commurications Fietiies 1 =
=

© Drigin Search Direction

£2 Master Connection 2 Master not cornec ¥ & Forwad ® o

Communications Cycle: 1 to 32 [Multiplier) Intenupt Input Signal Selection [(n0,¢ 1 Extemal Latch Siy =

Na. of Communications Fietries: 0 to 7 [time]

Tvag;liav E]yc\e [mns]  Communications Cycle [Multiplier] Origin Input Signal Sefection  [Phase 2 =
=% ms
4] ] q -
Dowrload | Upload | Compare |
mpare

Initialize: Cancel Set aXIS parameters Cancel
for axis 01.

Diigin Search Dperation

% ReversalMode 1 ¢ Reversal Mode 2 € Single-direction

Auto Communications Settingl seccsltescecscne

Edit servo parameters.

|8 CI1W-NCFT1 Axis Map
File Edit oOnlne Help

R e e s
[E] [CJ

Urit 2 New M

Setting value

‘. 2l selection 1
0B  Inputsignal selection 2

Double-click the Servo eeeee.. ] =00 Frs : :
; ®C1PRS0E  Oulputsignal selection 1 0000H
driver @O PRSOF  Output signal selection 2 0100H
@1 PRS10 Output signal selection 3 nanoH

®CPns11  Input signal selection 5 6543H

®1Pns12  Outputsignal reverse 0000H

[JPnS1E  Deviation counter overflow warnin... 100
[JPn&20  Deviation counter overflow level 262144
[1Pn522 Positioning completion range 1 3
[1Pn524  Positioning completion range 2 3
Pn&26  Deviation counter overflow level at.. 262144 hd
<F | v,

: Downlaad | Wpload | Compare: I

:. Initialize " Cancel

Set servo parameters for axis 01 as shown below.
Pn50A(input signal selection 1): 2881 ]
Pn50B(input signal selection 2): 8883 Click

Pn511(input signal selection 5): 6541

Save the project Refer to Page 2-13 “Saving Project” for details.



Design

Right-click MCH Unit

—

Point [Start Special
Application]

(

Select [Start with
Setting Inherited]

-

Add task, axis, program,
and CAM data

]

Edit position data,
parameters, program,
and CAM data

—J

Save the project

Starting CX-
Programmer

Setting
CPU Bus
Units/SIOU

Creating Unit
Configuration

Checking 1/0
Assignment

Using the MCH Unit

When using the MCH Unit (CJ1W-MCH71) instead of the NCF Unit, use the following settings.

Programming

Offline Debug Saving

As with Analog Unit, register the MC Unit to the 1/O table.

The MCH resides within the Motion Controller.

Then start CX-Motion-MCH using [Start with Settings Inherited].

When opening a stored project file after starting the dedicated tool, select [Start Only].
If [Start with Setting Inherited] is selected, a new project is created.

T { PLC I0 Table - NewPLC1
File Edt View Options Help
+ & CIIM-CPU13

4, Innet Board

- & [0000] Main Rack

: 00 [0000] Empty Slot
¢ gl 01[0000] Empty Slat

=10l x|

<3 (Orcupancy : L)(Urnit : 21) (Out: 1, In: 9)
)

CE Y

05 [0000] Empty Slot

06 [0000] Empty Slot

: 07 [0000] Empty Slot
- % 08 [0000] Empty Slot

: § 09 [0000] Empty Slot
[+-day, [0000] Rack 01

Change f Confirm Units
Unit Comment
SYSMAC BUIS Master 3

Urit Setup
Save Parameters

Load Parameters

—
— K

Copy Crrl+C
Paste Ghrl+Y
Delete

4 Uit Marufackuring information

Uit Error Log line
ok Swan

£5 NewProject - CX-Motion-MCH

Fie Edi Yiew Insert Crine Tooks Windows® Help

Start the MCH Unit as registered.

a Project

P NewPLCT
] Targetsiou @)
& Symbol

Pasition D ata

Parameter

Urit Settings

- Tasks

[B NewTask1 (1)
B Aes

=-[R Mation Programs

= Programs

=% Sub Programs

& CiM

(IR CIEEr Y =
|5 2 B o B P s X i

R R E

RN )G

Click to add task, axis,

NProeet f

roject

program, and CAM data.

=
o]

I

TR, Compite A Transter /-

Edit

loffLine 7

ion-MCH - [ TargetSI0U (3) : Ne: =18l x|
e

le Edit View Insert Onine Tooks Windows Help

SR Y - R L - EEE
RSB LOeRXEh |[ean |
>

_1xl o7 PROG P001 : 1=
= oo WOVE (301110000 [302]50000,
= s NOES:
& meio 004 SOUTPUTL = 1-
.

=0
007 MOVE [101]50000 [J02]75000;

0s  DYELL :
ni 008 HOVE (1011100000 [J021100000:
@ Tasks o0 NOPS:
NewTaskl (1) 011 #OWOBAL = 1.
5By s 012 HOVE [J01]SORIGIN [J102]$ORIGIN
013 HOPS,
D0 Newhsis? (101) 014 $OV0BAL = 0
B Newbiis? 02) 015 END:
& Motior s 016
[=Rd

S ms
NewSubProgram00 (500)

LR N T
M L T
[B MewCam1 (1)

ﬁg project tree.

Open the editing screen to edit data by double-clicking
position data, parameter, program, or CAM data on the

3 =
[RITO 5\ Conpie ATranster |

it [ n2,cizs  [orne /|

Click H Iand save the project to file.
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Checking 1/0 Assignment

As with Analog Unit registration, register the IN and OUT Units.

Fle Edt Yew Options Help

e In this example, CJ1W-ID211
‘ w - and CJ1W-OD211 are selected
! :|I o0 [3000] C1W-1D211(5C Inpu Ui as IN and OUT Units respectively.

0001] CIW-0D21 1{Transistor Sutput Unit)
o

Register basic I/O Unit

o1

2 [2210] CI1W-ADDS1-¥1{Analog Input Unit & poinks) (Occupancy @ 1(Unit : 21) (Quk: 1, In: 9)

3 [1550] CI1W-NCF7 L{Pasition Contral Unit) (Unit : 2)

04 [0002] Empty Slot

05 [0002] Empty Slot

6 [0002] Empty Slat

07 [0002] Empty Slot
& [0002] Empty Slat

-5} 09 [0002] Empty Slot

4w, [0002] Rack 01

K
1
7
1
1

CIM-CPULS  [Offline v

By registering Units to the 1/0O Table, you can check I/O assignment status.

CI1M-CPU13
g, Inner Board
{00001 Main Rack

Check 1/0O assignment

01 1(DC Input Unit)

01 [0001] CI1WHDD21 1 Transistor Cukput Unit)
02 [2210] CIW-RD0S1-Y1{analog Input Unit 8 points) {Occupancy @ 1dUnit : 213 (Out: 1, In: 9
03 [1550] CI1W-HCF7 1{Position Control Unit) (Unik : 23
04 [0002] EmptygSlat

----- 05 [0002] Empty Slot

06 [0002] Emply Slot

5§ 07 [0002] Empty Slot

08 [D002] Empty Slat PIC 10 Table - NewPLC1
linalog Input Unit & points  (CJ1V-ADOBL-V1)  (21)
09 [0002] Empty Slot $22100.0] Inputl Input signal use setting  <Enable(1Hex)>
D22100.1] Input2 Input signal use setting  <Disable(OHex)>
[+, [0002] Rack 01 D22100.2] Tnput3 Input signal use setting  <Disable(OHex)>
D22100.3] Inputd Input signal use setting  <Disable(DHex)>
D22100.4] InputS Input signal use setting  <Disable(0Hex)>
D22100.5] Inputé Input signal use setting  <Disable(DHex)>
D22100.6] Input? Input signal use setting  <Disable(0Hex)>
D22100.7] Input8 Input signal use setting  Disable(DHex)>
D22101.0] Inputl Input range setting  <1-5V./4-20mA(2Hex)>
P D22101.2) Input2 Input range setting  <+/-10V(OHex)>
In addition you can check addresses D22101 4] Inputs Input range setting  <a/-10V(0How)>
' D22101.6] Input4 Input range setting  <+/-10V(OHex)>
. . . D22101.8] InputS Input range setting  <+/-10V(0Hex)>
ass|gned to actual 1/0 with a p”nt out D22101.10] Inputé Input range setting  <+/-10V(DHex)>
. D22101.12] Input? Input range setting  <+/-10V(0Hex)>
D22101.14]  Input8 Input range setting  <+/-10V(DHex)>
D22102] Inputl Mean value processing setting  <Hean value processing for 2 buffers(0He
D22103] Input? Mean value processing setting  <Mean value processing for 2 buffers(0He
D22104] Input3 Hean value processing setting  <Mean value processing for 2 buffers(OHe
D2210S] Input4 Mean value processing setting <Mean value processing for 2 buffers(0He
D22106] Input Yean value processing setting  clican value processing for 2 buifers(Dlie
D22107] Inputé Mean value processing setting <Mean value processing for 2 buffers(0He
D22108] Input7 Mean value processing sstting  dMesn value procsssing for 2 buffers(llis
D22109] Input8 Mean value processing set <Mean value processing for 2 buffers(0He
D22118.0] Opieation aode sotiing . cHormal mods(Obex)s
8] Conversion time/resolution setting <1ms/4000(0Hex) >
C102210.0]  Inputl Peak value hold  clot used(DHex)>
CI02210.1] Input2 Peak value hold <Not used(0Hex)>
C102210.2]  Input3 Peak value hold  <lot used(DHex)>
CI02210.3] Inputd Peak value hold <Not used(0Hex)>
C102210.4]  InputS Peak value hold  <lot used(DHex)>
CI02210.5] Inputé Peak value hold <Not used(0Hex)>
C102210.6]  Input? Peak value hold  <lot used(DHex)>
C102210.7]  Inputs Peak value hold  <Not used(OHex)>

This I/0O assignment information can also be checked by IQ indication (IN:l, OUT:Q) during
ladder programming.

L a [Prodram Mame  MewProgrami]
[Section Mame : Section ]
l: 0.00 G 1.00
]
| |
p ,””:
7 /’

FEFFEFPEF S FFFFEE)



Design

Right-click from Function
Blocks

=

Select a folder from
[Omronlib] > [Position
Controller] > [NCF]

-

Select OMRON FB Library
"_NCF021_MoveRelative_
DINT11.cxf"

—

Enter “MoveRelative” for
instance name. Then
create a ladder program

Starting CX-
Programmer

Setting
CPU Bus
Units/SIOU

Checking 1/0 SEW]

Assignment

Creating Unit
Configuration

Programming Offline Debug

a Project

Programming

This section describes programming with Library (OMRON Standard Libraries) that allows
easier connection to OMRON'’s Components. OMRON Standard Libraries is a group of
Components provided by OMRON, which can be categorized into two types; FB Components
(OMRON FB Library) to be used for a ladder program and SAP Components (Smart Active
Parts Library) to be used for an indicator.

@® NCF Unit Programming with OMRON FB Library

Servo motor (axis 1) connected to Unit number 0 NCF is moved to position 2000
(command Unit) with speed of 2000 (command Unit/s) by relative move command.

80 Unit No.: 0
CPU NCF A
Servo Motor No.1
Servo Motor (Axis 1)
(Axis 1)

W10.00 W10.01 W10.03 W10.04 W10.05 Wwi0.02
Si T'} }ENO} }D/“ C}/“d ‘E/“
tart Trigger (ENO) one A rror Start No.2
W10.02
T
T J
Start No.2
P_On (Normally ON) _NCF021_MoveRelative_DINT ENO
(BOOL)

EN
(BOOL)

ENO
UnitNo. __| UnitNo (BoOL) | _ Positioning is completed

&0 | (INT) Done W10.03
Axis No. _| Axis (BOOL) | _ Command is aborted
Axis 1 - &1 | (INT) Command Aborted W10.04
Start No.2 _ | Execute (BOOL) | _ Error Flag
W10.02 ~ | (BOOL) Error W10.05
Position Command __| Position (WORD)

2000 Command Unit - &2000 | (DINT) ErroriD [ (Omitted)
Velocity Command _| Velocity

2000 Command Unitis — &2000 | (DINT)

=lxl

-5 NewProject
=D MewPLCL[CIIM] Offine
29 Symbols
i@ 10 Table and Unit Setup
; Settings
Lo Memory
2% Proarams
¢ = NewPrograml (00)
H 5 Symbols
B section1

B END

Select CX-Programmer Function Block Library File
Lock jn: | 3 NCF

] WCFO01_Connection1d, cxf
Q_NCFU]D_MDVEAbsDIute_REALl1.ch :. g gy
9 _MCF011_Moveabsolute_DINT11.cxf _NCF023_MoveRelativeZ_DINT10.cxF
Q _NCF01Z_MovehbsoluteZ _REALLO.cxf _NCFO30_Movevelocity _REALLL . cxf
Q _MCF013_Moveabsolutez_DIMT10.cxf _NCFO31_Maovevelocity _DIMT11.cxf
9 _MCF020_MoveRelative_REAL1L.cxf _NCF040_TorqueContral_REAL1L.cxP

S5 structured Text

o cit.
2 Copy
2 paste

Delete

From File...

|

File name: LNCFDZLMoveHEIative,DINﬂ1 cif

Open I
j Cancel |

| v allow Docking
Hide Files of type: [ Function Block Library Files{* cxf)

]

v

Float In Main Window

Properties

=

Paste the selected OMRON FB Library on the ladder, then enter its name (instance name)
(in this example, “MoveRelative”). Then create a ladder program as shown below.

I\ Project /'

ey [Program hame : NeswProgram | -
-5 NewPraject 0 =
=3 newpLCL[CI1M] Offline [Section Name : Section1]
) symbols
- 10 Table and Linit Setup w000 WHO.01 w003 W10 .04 W05 WHO 02
Settings — I { | % i1 1
g Memery StartTrigger ENO Done Pause ErrorFlag
=% Programs Wi0.02
1% NewProgram1 (00} (I
-2 symboks Stari2
i B0 Sectiont 3 I l
-~ EnD i
F 5 ,mm a
_NCFOZ1_MoveRelative_DINT " on 000 0oL Wi
4| |7 [EN ENO
Always ON Flag
a0 (T3 |BooL)| w003
Urithic: Dine Done
al (T3 (Bo0L)| w1004
niié Command_ Ak Pause
orted
wion2  ((ooL) |ooL)|  wioos
Start2 Execute Errark ErrorFlag
2000 (onm) (ORD)
Distance ErrorD

52000 (o)
[Velocity

OMRON FB Library is a collection of Components that OMRON provides as a Function
Block to use functions of OMRON'’s Units for PLC and FA Components much easier on a
PLC program. * For details, see FB Introduction Guide, Chapter 1.
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DeSlgn Programmer Configuration U%ﬁglsﬁ(u)su Assignment Programming Qi (DBl a Project
How to use Smart Active Parts
See Library I This section describes how to use Smart Active Parts. In this example, NCF Smart Active Parts
“Adjust Operation” is used.
From [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Designer] > [CX-Designer
Ver.1.0] to start CX-Designer. (Or select [All Programs] > [OMRON] > [CX-One] > [CX-Designer]
> [CX-Designer Ver.1.0].) Select [NS8-TVO0[]-V1] and [System Version 6.0] or later
Select [Library] fromthe B Test. Ctrl+B
[Tools] menu 2
", w Pesource Report.  Ctrl+R
° Data Check 4
Library alted ||
Import OId Library...
Place Smart Active
Parts on the screen.

-

Library
. [ SmantotiveParts_ ][ 100% =] e =] A Find G e g e
1. Select SmartActiveParts_E T'0] SmathotivePats E
Motion - NCF - 20 ot T
OutCIO InCIO folder -, (] Profibus Axis busy  Override setting Speed CMD value oy
- See,, (r—— () | Dissble || @53 (% | #06 | [ -5509990999 |V [pulse/s |V |
° E[ijm
= ‘IfE'EU’Ea"'E’ Hxisl@ Decel. stop| Servo urﬂockl -JOG | Orig.search| Orig, retuml
SR _NEF001_20_Adjust Operation
{7 DuCIO_InDM
£ /0uCio_incio 4 yaeee?® -
e 9 XEhd .
2. Select _NCFOO1_xx . oee""" 3. Drag & drop it on the screen.
_Adjust Operation
(Check the Title) 4. The selected Smart Active Parts are 5AP Communicalions Selting K
displayed on the screen. Desinton Acdress |
Setup Smart Active - Cammand Destination Part Mame SERIALA d
Parts Axis busy  Override setting Speed CMD value o1y —
O [ Disble |[20.9 |5 | 06 || 2000003 [V [pulees ¥ | e - 7!
R Destination Node Address 0 =
..' fiis| 99 Decel.etop| Servo urﬂock| -J0G | Orig.search| Orig. retur‘n|
...

DestinationUritho. cooo® ee® E
0o ®

I™ DeviceNet Slave Address 0 =]

1. Double-click

2. Set 4 to the Destination =*****"" "
Unit No.

3. Click [OK]

[ ok ] foancel Help
esveo®® O —I

<

eoe
ceseseve®®’
.o

Smart Active Parts
Setting is complete

fxis busy Override setting 7

O [Disdle [ 39995 % 406 || -9000w00m |[V[pulsess [V

perat ion
Speed CMD value (0.1)

Setting Smait Active Parts Communication address.
Flease wai...

Axis| 99 || Decel etopl Servo umookl -Jog | Orig. eearohl Orig. return e....
Setup is completed at 100% °°°°

4. Communication address is
Save the Project. I

automatically calculated according
Refer to Page 2-13 “Saving Project” for details to the corresponding Unit.
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Design

Offline Debug

This section describes how to debug a program using CX-Simulator, a ladder simulation tool,
without the PLC.
Additionally, Switch Box Utility is used as a virtual input tool.

% Untitled - CX-Programmer - [NewPLC1.NewPrograml.5ectionl [Diagram]]

= Elle Edit Wiew Insett PLC Program Tools Window Help y. ~ ;Iilﬂ
Click %l R T Y e RN L. ek A -0 MR- R Ty

aoaiSEmER|SI I | —oSHTRE®||Z Sm v B BEED

(Simulator connection button) CERBOS %2 E 4048 1c | % 55 \

==

Download Dptions Program transfer starts.

Download

C||Ck [OK] 0000000000000 00c000co e daflEhoeccccccoce
Includ

@ Progranmls)

Program Download to PLC NewPLC1

[0 Progiam indesx
Download successiul

CHEK[OK]  vvveeeeeenieeeeee b gaepees

0000000000000 00000 000
s Programindes——————————————————————

Transfer To/From:  |Memory card >

@ Transfer files of all tasks

" Transfer fllss by the task

¥ | Clear program memary

I~ Eschude ParHastLink, Peripheral) of PLE Settings from the
transfer target.
[Check when transfering CPU unit serial comms port settings
changed by NT Link auto-online ar CPU unit parameter edit of
C-Integratar.]

Screen when online

 yntitled - CX-Programmer - [[Runnip—" - —9LC 1.Nex
[D Ele Edit Wiew Insert PLC Frogrd

Togls Window Help
S —

so-.rj\u..... "

o o 1 &7 @A & 9 a0
- T B ! ot * =t
CX-Simulator debug DEH B8R % S n e ]| alLE W iR & &)
console is starts aoqHgEmER i | —ogEEELK [Bem w%
BREABROS sRPEE |25 ¢8| o
= Kevboard Mapping...
.'. - SEN o [Program Mame : MNewProgrami] e pping
., =48 HewPraject Options. ..
., E-F3 NewPLC1[CIIM] Monitor Made [Section Nams : Ssction1]
R q - . A
Starting Switch Box Utility e
[ 10,00 W10.01 Wi10.03 W10.04 W10.05 Wi10.02
Select [Tools] > = — | | | % 11 11
. . o Start Trigoer ENO Dane: Pause ErrorFlag
[SwitchBox Utility] . By Eroriog o2
o' o) PLC Clock —
o® © Gt Memory Stari2
o = B Frograms ) 1 MoveRelative
. : E--Q MewProgrami (00) Running 7
o® 54 Symbols _NGFO21_MoveRelative_DINT
Run PLC -~ Sectionl P_Cn (BOOL) (BOOL) W10.01
: -8 END S | Y ENC __|
E-ﬂ FU _ o] x|
B Che) view(v) PLO(P) Addressl) HelpiH)
| Untitied Growp |
Bit Monitor =
Comment | o2 | Comment Address [ _value Comment
0004, 110,01
r— Wi10.02 I
4i10.03
[ W10.04
[ 2 orr || 410,05 | orr]
=
5 O . [ c o 1] 4 | »
[F1Program [rznonior [Farun Fa(Debug) |F5Au|u Online |rﬁsmd| Port
FTBIt Monitor |rs-w Manitar |FQWalch Mor\ilallFWComment |F11Grp Commer\'l F12Network Set |
X |® [enm-cruia PRG  [HEX L'LI
b, Project / 2 x4 Mame: Address or Value: | Comment:; |
For Help, press F1 ° [NEwPLC1{Simulator) - Monitar Mode | s.0ms [s¥NC [rung 2 {0, 0) - 100% [ v

Switch Box Utility
It is useful not only for virtual input by simulator but also for debugging
while checking the PLC’s wiring or setting the DM and other initial values.
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Saving a Project

Saving a CX-Programmer file

Unit setting, Unit parameter setting, and programs using the CX-Programmer
at once.

" Untitled - CX-Programmer - [NewPLC1.NewProgram1.5ectionl [Diagram]]

Offline Debug

Saving

a Project

can be saved all

File Edit Wiew Insert PLC Program Tools MWindow Help -|5' ﬂ
[ D e an @0 [ aNE|TR|asBR|LIELR R2RDRRT L w5
< & Cpen... Cri+0
| S [Garsuewe | —opEEEL x|[2[Sm (9% B BERD |
’Euﬁave Clrl+5 %&ﬂ!ﬁ\kéﬂ
From the [F|Ie] menu, AR = ﬂ v o | [ Prooram hame : NewFrogrami] -
=] .
Reusable Fil b
select [Save AS.. ] SEEHDED [Section Hame : Sectiont]
Funiction Block. 3
W10.00 W0.m w1003 W10.04 W10.05 W10.02
Load Comment{Program I |} 11 |} 14
S GagrantfFisgian StartTrigger NG Done Fause ErrorFlag
W10.02
B@ Compare Progran,..
Start2
Page Setup...
m Print Preview 1 ; MoveRelative
& prirt.. Ctrl+p _NCFO21_MoveRelative_DINT
DINT
1 Gleiley 5 - P_Cn BO0L) (BOOLY w001 _»|;|
NFo B 2 mame:|  address or Value: | Comment: |
Saves the project with a new name [MewPLC1 (het:0, Node:0 - Offline [ [ fruna 2 (0, 0 - 100% 7
Save it with a name. In this example save as “Samplel”.
Save CX-Programmer File EH
Savajm:laDemu d & ¥ B~
Y Y .
File hame: E L Save esecces (Click
Save a3 type: |D<-F‘mgrammer Project Files [* cxp] j Cancel I
P

Saving CX-Designer and
CX-Motion-NCF/MCH files

Created data can be saved for CX-Desigher and CX-Motion-NCF/MCH.

Save CX-Motion-NCF as “Sample2.mnf’ (CX-Motion-MCH as “Sample5.mnh”), and CX-

Designer as “Sample3.ipp”.

Saving screen for CX-Des

Saving screen for CX-Motion-NCF

Save Project As

Save ir | =4 Demo Savein | 23 Demo

igner

> D
File name: ISampIEZ . Save I Pie name: |Sample3

Save I

L]
Save as ype: IEX—M otior-MCF File[* mnf] o Save as ype: IF'lDiECt file{IPF)
.

j Cancel |

i

j .‘ Cancel |
. 4

If you run a dedicated Support Software such as CX-Motion-NCF or CX-Designer when CX-
Programmer is started, the same default folder location as that of CX-Programmer is used for
reading and saving files. It allows easier CX-One Support Software file management.
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This section describes connection to the machine, transfer of programs, creating Unit settings

offline, and how to debug.

Reading a Project

From [File] > [Open], select

the file name “Samplel” Use CX-Programmer to read the

= Cx-Programmer
IC Toos Hep

B =lofx|

N E|Ek(tme[oc nrn(ee|[asBaLnEi2(e sl BBDD[L W[5

EEBERE t#rw | —opaeilx|[Bcalesen|EBERD |
EREROE | 5

Look in: [ 24 Demo =« &Ik E-

Fie pame:

[Sampit o Dpen
Fiesolype: [ CXProgrammer Poject Fies . crp) - =)
4

e e | |7

For Help, press FI

~_-

Ladder program “Samplel” is retrieved.

= Sample1 - C#-Programmer - [NewPLC1.NewProgrami. Sectiont [Diagraml]
[ Hie Edt View Insert PLC Program Tools Window

Unwmm\ém%%a\pq\ul;a's\v'eumg,@m;; NEEEEEEEEEEETIEY

[raaESEmER R wuw | —oo B a2 %% %% uBHERE |
|EEEEEEEE T T
Zx [0 T

1]

NewProgram]

=8 toront 3
=B NewPLCI[CIIM] Offline (Section Name : Section!]
it
91 10 Table and Unit Setup 4 Wit w03 wi004 W1005 W1002
Fellins — it it 1t
< oy S oo P
=% prograns
- Newkrogramt (00)
ERs
& seciont . Movesative L
Sew =
& IF Functon Bods
B _JiCF021_HoveRelatve_DINT oo oo oo oot
& [ | R
[
@oon|  wiom
G
@oon|  wiome
ComnaiPR0] o
e
@oon|  wioss
Error ErrorFlag
(WORD) |
)
{1 i >
\Proist 0.5l iobal Name: | Adcress or Vokue: W10.00  Comment: [StartTigger
For Hel, press F1 i [NewPLCI(Neti0,Node:0) - OFine. T I a0 (0,0) -100% | v

et

project “Samplel” saved in the previous section.

In /O Table Unit setting function, the Unit parameter setting configured in the previous

section is also retrieved.
7 PLC IO Table - NewPLC1
) Fie Edit iiew
DOUble-Cllck the I/O -l CI1M-CPU13
0 g -4, Inner Board
Table Unit setting 21 35 [oone] i Rack
- § 00[0000] CI1W-IDZL1{DC Input Lnit)
5 01 [0001] CI1W-CD21 1(Transistor Oubput Uirit)
9 i ‘Analog Input Unit
- § 03[1550] CI1W-NCF7L{Position Contral Unit) {Uinit : 2)
§ 04[0002] Empty Siok:
5 0% [0002] Empty Slot
~§ 06 [0002] Empty Slot
51 07 [0002] Empty Siot:
3§ 02[0002] Empty Slot
- § 09 [0002] Empty Slat
-4y, [0002] Rack 01

[_[o0x]

Options  Help

cupancy ¢ 1)(Unit : 21) (Out: 1, In: 9)

CIM-CPULE  [affine 4

[C31w-AD0B1-¥1 [Edit Parameters] =]

Displaed Parameter [

Item Set Value Unit Al

IRt Input signal use setiing Enable

Input2 Input signal use setting Disable

Inputd Ingut signal use setiing Disable

Inputd Input signal use setting Disable

Innuts Ingut signal use setiing Disable

Inputfi Input signal use setting Disable

IpUET Input signal Use setting Dizable

Input Input signal use setting Disable

InpUt Inputrange setling 1-5vi4-20mA

InpUt2 Input range seting EAL

InpUt Inputrange setting AT

Input4 Inpul range seting 107

Inputé Inputrange setting +10Y

InpLtG Input range sefing EAIT -

b
= =
= |

Trarsteint oo | | SrawiePSiating) | | Comeme. | Aot |

Set Defaulle Cancel
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Online Connection to PLC

Verify that PLC model and communications setting created offline and the actual PLC are
correct.

| Change PLC [ %]
"DEVICE Narme ‘

1 T \ d Uit Set Device Type
able and Unit Setup
Settings IC‘HM Sellings
G Memary L D

Double-click PLC  ==========

ﬁ MNetwark, Type ) 4
Programs
Toob, Settings... ])
b NewProgram (00) {I oonue / ¢ _ etz
1 Symbols Eummantll ,'
Sectionl =]

: 3 EnD
- IF Function Blocks
L _MCF0Z1_MoveRelative_DINT

I Project ok | Cancel | t Hep |

Check PLC model. Check communications setting.

K1

Device Type Settings [C11M] E Network Settings [Toolbus] [ ]

Geneal | Network Diiver | Modem|

Cannection Data Formal

Fort Name: - Data Bl [8 =l
Baud Hate:  |9600 hd Earity: Mone 'I
¥ Baud Rate Auto-Detect Stop Bits l__l1 =

Make Defaut |
Confirm that automatic
communication speed recog
is checked.

™ Read Only

i

I~ Read Orly

File: Memar
( Hone - ™ Read Orly

"Tlmef # Clack

¥ Installed

nition

Make Default T

0k | Cancel | Hen | G

= = Samplel - CX-Programmer - [NewPLC1.NewProgram1.Section1 [Diagram]]
Click & [FI Bl Edt Mew Insert PLC Progam Took Window Help p— RIS
IC o T L L e e B Y MR -EEETTEY

aoaEEEBERGAr#Ew | —o adBEREEE I I =

(Online connection button) ERRROE &> BEE|S 805 % e
Wdﬂ © o [J FProgram ame - Namegraiu. -
B2 NewFLCI[CIIM] Offline [Saction Name : Section1] 4
2 symbals :
-] 10 Table and Unit Setup WHEOE T waom W10.03 W10.04 W05 WI0.02
h A 1A ) |

Settings — | 4 I t 1 4
e Memary StartTricger : ENO Done Pause ErrorFlag
=% Programs W
=53 NewProgramt (00) (S—

2 Symbols Start2 :
‘ - K
If a connection cannot be established with the PLC, ! o NG WoveRtive DT
A . ) TweRelative_DINT 5an B0l oo wioo
you can use the automatic online connection Ll F _;_I
i [T A | 3
funCtlon X A[cllal Hame: | Address or Valus: [W10,00 Comment: [StartTrigger
Save your current project data before using this o TR L B ‘ [ Gl Z
. . . . . R4
function because it clears project data being edited. K G
. . *
When USB conversion Cable (CSlW_CIFSl) IS used lzr—[lsmuneuNewPLc1.NewPrngranu.se(tmn1[Diauram]] =] E3
3 q PLC Progran Tods sWindow Help =18 x|
for connection, specify the COM port number of the W O O Y YA EEEIPTEY
USB port used. R ra s A B e L

[EEERIE &=rF =28 2.0k &5 |

%‘ = o | [ Proram bame - NewProgrami] =
e "t nRR [Section Name : Seetion]
16 Table: and Uit Setup Wiooo 7 wiom WIn0E w1004 WID0§ win.oz
R a Settings A n Iy 14 14
(Automatic online < pa
. By Error log e
connection button) Bocam T
Gt Mamory Start2
£ Programs ]
R : . 153} NewProgram1 (00) Stopped
Serial Port Selection Check: B o 7
. . P sectiont
[PLC] > [Automatic online Sew el o e
a o =-IF Function Blocks Always ON Flag
connection ] > [Sel’la_l Port ¥ _NCF021 MoveRelative DINT | [ |
I\ Proiect / =l4l[Giobal Mame: | address o valus: [W10.00 Comment: [StartTriager

Se |eCtIOI’l] For Help, press F1 [ [NewPLC 1(Net:0,Mode:0) - StopfProgram Mode [ [svnC frung oo, 0) - 100% [ 4




Online Transferring

Online Debug on Reading a Program

. . Connection toa
a Machine Project to PLC Vi Debug
Transferring to the Machine
Transfer programs and Unit setting parameters created by offline project to the PLC.
In this example, data is sent at the same time to various Units using the batch transfer function.
[Data to be sent]
CPU Unit: Ladder program and PLC System setting data, I/O Table data
CPU Bus Units and Special I/O Units:
AD Unit: Range setting of inputs (1~5v / 4~20mA mode)
D File Edt Wiew Insert W Program  Tools wmnw Help =18 x|
u\rﬁ\é[@wwm atw plazEalll AR LS BERE| S w (%
Wnrk Onfline Simulator: Chrl+Shift 4+
TEEEE e I EE e A2
’7@ R OE Auto Online 3
T OperatingMode » — —
Monitor 3
® 145 Compile all PLC Programs N
Select [PLC] > [TranSfer] ®eoe,d ﬂ ISSWTZ‘D]‘; and L P’“‘J'E‘mzhﬁtke”““"s W 0.01 w003 WiD.04 w005 W0 .02
9 ® e o [Tl settings utamatic Allacation, } {1 .t {4
> [TO PLC] ;:,tguli, ooy ;r;qram[ A:Jgnr:em; End D;{:e Aﬁn Error flag
Errar lof
PLC c\nik Function B|utk Memnrx. ®eoq, »
4} Memor: 0 PLC...
1B Pn:u;ra:s Partial Transfer % =
B @ WewFrogre Pratection b R Compare with FLC... DT
Clear All Memary Areas —— ool o
¥ _NCFOz1 WLy Data Trace. a0 A‘E‘NR\] (ESOLJ Wi 0.03
Time Chart Monitoring. .. rithla. one Done
Force : » " —"LI
b, Froject / =t P address or Valus: [win.oo Comment: [Stark
Transfers data ko the PLC (downloads) [ |NewPLC1{Met:0,Mode:0) - Run Mode [ 18ms [s¥nC [rung 0 (g, 0) - 100% 7

Click [Transfer All] .. G

PLE:. T\l;m'PUZI R Transfers all the data to the PLC. Do you wish ta continus?
Inciude: .'-. Cancel c0cc000000000d0000 || k Y
e | ) ] Click [Yes].
[ Settings ®e,
197 10 table °
[ Special Urit Setu Transfer All ‘
9 ombk @ Program transfer starts.
I@ Comments annlnad
< b 0 Program index ogram Dnrlocd o PLE New .
Program Ds load to PLC NewPLC1 . C“Ck [OK].
- Symbols, Cornments, Program indss .
Transfer To/From: IW Deriond faled N Next Page
& Transter files of all tasks °
' Transter files by the task < -
¥ | Clear program memery
™| Exclude BortHostlink, Perphersl) of PLE Settinas from the:
CJ1W-AD081-V1
tramsfer barget CX-One CIIW-0C211 '
Tl e Unit No.= 21
Antegrator.
e CJLW-NCF71
) (CIIW-MCHT71)
Connection Cable Unit No.= 2Hex
CS1W-CN226(2m)
] ) CJ1W-DRM21
Program and configuration data Unit No.= OHex
are transferred at the same time PLC1 Node Address= 01
to CPU Bus Units and Special CJ Series PLQ CJ1, —  CJIW-SCU41-Vi
. Gl o p _
1/0O Units. o8 8 Unit No.= 3Hex
+ H o [
i i BB
= T~ CIIW-CLK21-V1

CJ1w-ID211 Unit No.= 1Hex

4 ~ 20mA Node Address= 01
' J Connection Cable Termination Resistance
XW2Z-200T(2m) Setting= ON
NS Series PT Sensor
NS8-TV00B-V1
System Version 6.0 or later

Servo Driver
R88D-WNO1L-ML2
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Then data is sent at the same time to NCF Unit and the servo driver connected to NCF Unit.

[Data to be sent]
NCF Unit: Common parameters, axis parameters
Servo Driver: Servo parameters

From CX-Programmer, display the 1/0O Table,
then start CX-Motion-NCF by [Start Only].
=] E3

T | PLCID Table - NewPLC1

|# Untitled - CX-Mation-NCF [—100]
File 1§dlt View Cplions Help o U EE 0T Eh
# CIMcPuI3
g, Inner Board
" 3 g =14 [0000] Main Rack
nght-Clle NCF Unit 5 00[0000] C31W-ID21 L{DE Input Unit)
o, 5 01 [0001] CHW-OD211(Transistor Output Linit)
Ce, I 051-1(Analog Input Uit 8 points) (Occupancy : L)(Unik : 21) (Out: 1, In: )
oyl Unit (Uit : 25
-5 0s[0002]Er  Change f Confirm Units
o 06 [000Z]Er  Unit Comment
;1 07 [0002] €1 SYSMAC BUS Master »
-5 us[0002] Er
. . o os[oooz]er  UnieSetup
Point [Start Special 1 ey [0002] Rack 0 v Parareters
Appli q oo, Load Paramsters
pp |Ca.t|0n] Start Special Applic Start with Settings Inherited
T “CERY o
Copy 00®® T
gee®® © ity
‘..0" Delete
e
Click IS onl T o Uit Manufacburing infermation
IC [ tart On ] J Uit Error Log -
)\ IEE—— G ST ] Fress [F1] to display help, 4

Open a saved project and transfer all NCF Unit and servo driver parameters.

To prevent a servo driver operation using a ladder
program, you must set the PLC to PROGRAM mode.

i Untitled - CX-Motion-| i [w] 4 88 Sample2.mnf - CX-Motion-NCF M=
File, PLC  Unit  Hel
Click [= ........."-i\ =L
=M sa@8 4
Bl open [Z] <]

Select “Sample2.mnf” .

Click Open

Lock jni [ 4 Demo =] + & ek E-

DEMOD

File gam{ S ample2.minf >

i [

°° '

o ofUE3 % o|FiMplgr s EFFsiomerh © © © © - Cancel .,
2

Press [F1] to display help.

N |

(il GGIG

Double-click NCF Unit

& sample2.mnf - CX-Motion-NCF
File Wiew PLC Unit Help

DeEdas 68

=1 B3

.
Press [F1]to d\spﬁly help.
.

Double-click NCF Unit.

N S

& =

» 1

Click @

If it does not go online, click @
and check the communications
setting between the personal
computer and PLC.

Press

i@ Sample2.mnf - CX
Elle Wiew PLC Unit Help

= o x|

DedElas®lh sl

|8 C11W-NCF71 Axis Map [<]

5l Ele Edt onlne Help
ﬂ e 1""|1’"‘|1"" i
Bl

iz 0 Mew Driver 01(RB8D-WHOTL-MLZ]

Press [F1] to display help,

I I
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click ¥

Click

Click [Online] > [Test Run]

Reading
Project

........il.@ L

Online
Connection
to PLC

Transferring
toa
Machine

Program
Debug

1H& CI1W-NCFT1 Axis Map [ x|

File Edit Online Hel

=3 ; Download All [Computer ta M Unit]

Axiz 01 Mew Driver 01 [HBED-W'NDT L-+L2)

Acquing Access Right...

The Unit restart confirmation screen will be displayed during data transfer. Click the [OK]
button after confirming safety. Also, in the case of communication was not established

between the NCF Unit and the servo driver, confirm the axis number and restore power to
the NCF Unit and servo driver.

When parameter transfer is completed, confirm that communications is performed normally and
has not resulted in an error.

Monitor the NCF Unit. Confirm consistent scan list (axis configuration) and communications
status and that no axis or common Unit error has resulted.

| C31W-NCF71 Anis Map Unit monitor - New NC1 [Monitoring {connection established)]
File Edit OCnline Help

__ [ =

{Eatus | Fresent position |

12 3 4 5 6 7 8 9 10 111213 14 15416
EEC LT orr | orr Jore forr fore Jorr Jore lore Lore Lorr Lorr Jorr ] orr Jorif orr |

[ eIV orr [orr Jorr Jorr Jore lorr Jore ] ore | orr ore [ orr | orr | orr fort | orr §

Ais ermor .|

Urit comman errar Enror Resat Al .

Erorcode 0000 Terminate
B Unit monitoring.

Next, perform jog operation. Carefully read the displayed cautions, then perform the operation.
To perform jog operation, it is required to establish a connection, servo lock, and jog setting.

8 CI1W-NCF71 Axis Map E Test Run m
File Edit | online Help — Gelected Asis

ﬂ | Download ko NC Unit
=]

Upload from MC Unit
Compare

Statu
“ IVCDmm o8| Busy B Fresent Value 0 Command Unit

W MOTL-MLZ] [~ Establish/Relzase Connection —J0G Setting:

write Flash Memary

Unit Monitor

" Speed Desighation

5000 Command units/s
@2 ;IE Rel
seass Override
E stablished lrl_ Enable I-‘[IIJ =

o

Device Infarmation

~Servo Lock/Unlock———————— M
—J0G Button———————————
ﬂ Servo Lock
I Servo Unlack 4 h
= Uriit common error i ennor

Error code | 0000 Reset | Enor code IDUDU Feset
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Click &)
—

Select file .mnh

—

Click [Open]

Click &

Select [All Data]

]

Select [With Servo
Parameter]

—

Click [OK]
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When using the MCH Unit, transfer data from the CX-Motion-MCH to the MCH Unit and servo
driver connected to the MCH Unit.

[Data to be transferred)]

MCH Unit: parameter, position data, program, CAM data.

Servo driver: servo parameter

Display the 1/0O table from CX-Programmer and start CX-Motion-MCH with [Start Only].
(Refer to NCF Unit for starting from the I/O table.)

Open the saved project and transfer Unit parameter, position data, program, CAM data, and
servo driver parameters to the MCH Unit.

To prevent a servo driver operation using a ladder program, you must set the
PLC to PROGRAM mode.

£:® C¥-Motion-MCH

Ele Yiew Tools Help
ﬁbﬂhﬂ»\@éwﬁ\ﬂgz\ﬁ Il

BEEERRE e nA||lean
— P

o x|

EEFEE |6 @B EE

Look inc [ (3 Dema | = ® ey B

2x

File nam
Files of type: | Cx-MotionMCH Prcject Files(mnh) ~|, o Cencel
.

' Project /

EEEEEEEEEEEEEEE e =
|
I AT T Compile: A Transter /7
Edit [ y
EEEEEEEEEEEE NN EEEEEEENEEg
ll......
¥:® sample5 - CX-Motion-MCH -0 5[‘

4 1l
” Fils Edt Yiew Insert Orlins Tools Mndnw?ui\p

un|«»\@§|aeaaa|5'<z i .al\@\f?“ﬂﬁ!ﬁ@%[

If it does not go online, double-
click PLC in the project tree and
check the communication
settings between the personal

-5 NewPLC1
- TamgetsiOU (3)

Transfer Data To MC Unit

- Select MCH

iion Dala - computer and PLC.
arameter <
UniSetngs 4w n = Al Data
. p-m Juciem Peclied Data
-
awmuuunup® (@ MewTask1 (1) A System Parameter
ymmmunn® By Aues
-[® Motion Programs 5
E .? Progiams e S With Servo Parameter
: MewProgiamd (0) ' " WithoLE S ErwD Harameter
NewRjagrasn® (B
e st ®ifans [ Positior st |
hans® L [l MewSubProgiamson
Lunt upm @> CaM | Program
-
Laset e [E) NewCam1 (1) £l € Individusl
- ’7
x =
)| [Flampas =
assEEEEEEEEEESEEEEEEEESEEE ._’ Cancel
jEEEEEEEEEEEEEESEE - j
TR, Compile
Edit [ lontine £

The Unit restart confirmation screen will be displayed during data transfer. Click the [OK] button
after confirming safety. Also, in the case of communication was not established between the
MCH Unit and the servo driver, confirm the axis number and restore power to the MCH Unit
and servo driver.
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Transferring NS screen data

This section describes how to transfer screen data to the NS through PLC without changing
Start NS transfer cables
program ) ) )
From [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Designer] > [CX-Designer

Ver.1.0] to start CX-Designer. (Or select [All Programs] > [OMRON] > [CX-One] > [CX-Designer]
> [CX-Designer Ver.1.0].) Open a project saved in the previous section.

Select [Transfer]-[Transfer[To PT...]] from the [PT] menu.

[ signer x|
*Communication between the NS and the PLC

Click on Setting st e must be established before transferring screen
: SN data through PLC without changing cables.

Stee Tranefpr Setting
[ ot If “Connecting...” is displayed at the right bottom
of the screen, use Auto Connection (See Chapter
[~ Do nat show the dialoe again, 3 1'3 “Setup NT Lil’lk") tO Connect the NS and the
PLC before starting the following procedure.
Setup - If the communication between the NS and the
communication route 51 PLC has already been established, you do not
- need to perform the operation described above.
. l..l.l.l'.. v s ihiough PLC
Check “Pass thru PLC” .eeeccessccccc®®®fFlicamn  bapdn) @
H U] .- [2]7 . “ ” .
in the Comm. Method Bt Check “Pass thru PLC” to activate
" .
W|nd0W ’Fv;::::a}::::::vADNS/EDmDuIev :q)a!amangev o . the “PC 9 PLC 9 NS” route Settlng
B ] | | v X _ Comms. Route
=T = || | m
— e |
. s . n iz
Bark [Network] "
— .
m | - (2conms : - [ e (2
] e = | ‘ Pu:---PLE-‘-[uE|wmk]---Pu:--N5
: :
l OK(O) I Earu:e\&.] == .H;D‘!] R ° Select PC - PLC - NS-
Select Serial(Toolbus) . Setup “Data transfer to po l—_l «+eeee Set the serial port
....... the NS through PLC". e =] COM No. for PC
Cee, ..  Data transfer to the NS thiough PLC— [Eecive =] - PLC connection.
IRE TSR | Then, press OK.
o, |, omms. Methd to 600)
®|SenalToobu ~ 8 Set () —
Select NT Link -, . =
Press each setting button.
Seee., ]
Port R5232C =
e «eeee Enter NS Unit No.
Then, press OK.
Transfer screen data Caree
: =
. - Auto-teset after the Carnms. Transter[Computer->PT]
Click OK to start transfer % pass e L
[ Autoreset fter the ‘r-' m @
transmission PC-PLC--NS
.'. I PE[—”PLE [Nelwmk[]z']PLE— NS
.0 - Direst data transfes b NS/ Computer: [~ Data tianster to the NS through PLC
.. R Now downloading(46%)
. [,m SeL (5]

Cancel

o Drive:
. B
. | o
. Bar:
.
T .
° 2)Comms
NTLrk =

. Screen data transfer is
l oK) I Cancell) HepiH) Complete at 100%.
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Transfer programs and Unit setting parameters created by an offline project to the PLC.
In this example, data is sent at the same time to various Units using the batch transfer function.

Monitoring

Monitor ON/OFF status of contacts and coils.

o= samplel - CX-Programmer - [[Stopped] - NewPLC1.NewPrograml.Sectionl [Diagram]]
@ Eile Edt Wew Insert PLC Program Tools ‘window Help P _ =] %]

il

Click &2 | uwasue{ e o o oo £ in o s i o 0 {2 43 0 f e o (B R W 0 R B )R [ w0 2
aoqifgEmErR(trnew ) —ooBaEL Kk |G SHlweas B TEEE |
EREEEEIEEREEL [FETE

CX-Programmer ¥5.1 E

Make sure that there aren't any problems if the PLC is skarted,
Do waou wish ta switch the PLC inko Maonitar mode?

(4

Click [Yes] iEmmmsEEEEmEEEEEEEE

|rt::l?|:h ... ON/OFF of monitoring

9 gample1 - CX-Programmer - [[Running] - NewPLC 1.NewProgram1.Section1 [Diagram]]
If_}lﬁile Edit Wiew Insert PLC Program Tools Window Help =] x|

DEd RSk rmeoc(ank(ew [fegain RERasrSBTRR L %
sxal BEmErErrew | —opsaTelx|[ZleaetuuiE®"EEE |
EEERDS kS P EE L 8E w8

sl fo [Program Name : NewProgram1]
=488 NewPraject 0
= [CILM] Monitor Mode: [Section Mame : Section]
= Symbols
@7 10 Table and Unit Setup W10.03
[3) Settings — I} bt Frame color changes to
Memary card Start Trigoer EMO Diane Y .
. Error log SSr——— a specified color during
8) PLc Clock — Function Block execution.
gt Memory Stert2
=% Froarams 1 MoveRelative
=g} NewPragram1 (00} Running s
-2 Symbols _NCFD21_MoveRslstive_DINT
& Sectiont P on (B0CL) (BOGL)
& eno e El EhO
- Function Blocks Always OM Flag
¥ _NCFO21_MoveRelative_DINT
a0 (INT) (BOOLY|  Wi0.03
Aiithlo Donel  pone
il
81 ] (BOOLY| w1004
Jiis Command_&b | payse
orted 0
winm  [Eool (BOOLY| w1005

Start2 HExecute Ertore  Errorflag
3 (i

(DINT) (WORD]

Distance ErroriD L

Current parameter
value is displayed.

[41 | _>|LI

[\ Project / x4/ Gobal Mame: Address or Value: [W10.00 Comment: [StartTrigger

Far Help, press F1 [NewPLC1{Net:0, Node:0) - Monitor Made | 1ems [S¥nC [rong 0 (0, 0) - 100% v

(DINT)
Jelocity




Online Debug on
a Machine

Reading

Project

Online Transferring
Connection toa Plgo%ram
to PLC Machine ebug

Monitoring -2 Changing the Current Parameter Value

Change the current value of contact or channel through conductive monitoring.

o

Move the cursor to D100
of input parameters

Right-click, then select
[Set/Reset (S)] > [Value
(V)] from the pull-down
menu

or

Double-click

Or

‘

[Program Name : NewProgram]
[Seetion Mame : Sectiont]
1i10.00 Wi w1003 w04 Win.0s winoz
— | 1 11 14 }4
StartTrigger ENO Done Pauss ErtorFlag
w1002
—
Start2
MoveRelative
_NCFD21_MoveRelative_DINT
P _On (B00L) (B00L) Wioot
En ENE)
Always OM Flag
50 (T |ooL)| w003
Joinitil Donel  Done
o
81 (T |ooL)| w004
dazis Command_A6 | Fause
arted o
" Are0oLy @ooL)|  wiaos
~
e Stata  Jrecute Erort  EnorFlag
i o
Siomm (WIORD)
Ibistance ErroriD |
22000 (DINT)
AWelacity

Change current value of the input parameter.

Set New ¥alue

|

Address: |w1 0.02

Set
Data type: IEDDL 'l e
|1—

\

Walue:

0, 1 (OCH)

=

>IIIIIIIIII C“Ck

Ensure to add "#" (hexadecimal/BCD)
or "&" (decimal) to the left of the value.

a [Program MName : NewProgrami]
[Section Mame : Sectiont]
WH0.00 Wil 1003 WD 04 WHo.0s WD 02
— ! { 11 4 14
StartTrigoer ENOD Done Pausze ErrorFlag
Wi10.02
—
Star2
MoveRelative
7
_MNCF021_MoveRelative_DINT
F_On (BOOL) (BOOL) w1001
EN ENG
Alavays OM Flag
&0 (IMT) (BOOLY V003
HUnitho Dane L Done
a
&1 (INT) (BOOL) W04
Jiig Command_th L payse
orted 1]
Winoz | 4mooL) (BOOLY V005
Start2 Execute Efrort-  ErrorFlag
: 1 a
| 1Ty (WORD)
-Distance Erroril |
&2000 (DINT)
JWelocity




Start-Up /
Adjustment On-
site

Program
Modification

Unit
Parameter
Change

Online Program Modification (Online Edit)

Move the cursor on the
circuit you want to modify ==s=s======

You can use drag-and-
drop to specify more than
one circuit at the same

time

Select [Program] >
[Online Edit] > [Start]

Shortcut [Ctrl]+[E]

Move the cursor on the
contact you want to modify
and double-click

UG

Select [Program] >
[Online Edit] > [Transfer
Change]

Shortcut
[Ctri]+[Shift]+[E]

[Section Name : Sectiont]

[Program Meme : ewProgram1]

W10.00 w001 wi0.03 10,04 W10.05 wino2
I { | vl 14 1
Start Trigger ENO Done Fause ErrorFlag
w1002
Start2
.-
MoveReltive
u
L _NCFO21 _MoveRelstive_DINT
u
- P_On (B00L) (BOOL) wi0.01
u (] BN~
- s ON Flag
"
" &0 (INT) (BooL)|  wioo3
. Uit Donel  pone
" i
"
. &1 (INT) (B00L)| WD
. s Command_Ab - pause
- ortett a
- W02 |(BOOL) (B00L)|  wADDs
: Startz  -{Execute ENOrL  Errorflag
. 1 [
" &2000 (DINT) (AORD)
" bistance ErroriD|-
"
"
" 82000 (DINT)
. Velocity
"
'.
o
o |l Program Hame: MewPragram1]
[Section Name : Sectior ]
wi0.00 wino wi0.03 wi0.04 win0s w002
— | ] | 11 i1 i1
StartTrigger ENO Done Pause ErrorFlag
win02
—
Stert2
1 MoveRelative
7
_NCFO21 _MoveRelative_DINT RLLLLLLI
P_on (BOOL) (BOOLY : W10.01 ;
=
smmmm A%éﬁhénnnnn-------------------------. W
. "
20 (T (gooL)[  wano3 . v
Hiintia Dong Done Ammunm '\‘
o
& (T ool winod
Haas Commard_Ak Pause
orted a
wiooz |BooL) gooL)[  wanos
Start2 HExecute Error ErrorFlag
1 o
82000 (DINT) (WORD)
Hpistance ErroriD)
&2000 (DINT)
Jelosity

~—

=| Detail >4

Double-click

Enter the contact number you want to modify (W20.01 in a circuit example).

=

0 o | [ Prooram tame : NewProgrami]
[Section Mame : Section]
w1000 winm W03 w1004 Wi00s w002
—t ] | i1 i1 11
StartTrigger ENO Done: Pause ErrorFlag
w1002
—
Startz
1 MoyeRelative
7
_NCF021_MoveRelative_DINT -
P_on (ECCL) (BOOL) -
— En )
"
Abwvays O Flag .
a0 (T ool winos X
Linithlo Done: Done
0
£ (nT) (BooL)| w1004
it Commantd_Ab Pause
orted a
winm  ||(pooL) (gooL)[  wioos
Startz Execute Error ErtorFlag
1 o
52000 (DT (AORD)
Distance ErrorlD)
52000 (DI
Velodty
>




Start-Up /
Adjustment On-
site

Click E

(Online connection button)

Select [PLC] > [Transfer]

> [Compare with PLC]

Click [OK]

Click [OK]

Click [Section (1)] > annmnnnnn by -ﬂ Mnermnic View '

[Mnemonic View]

Program
Modification

Unit
Parameter
Change

Verifying Program

After modification on-site, you can verify it with the designed program and display the
differences graphically. This allows for easier checking of the parts modified on-site.

1. Read the designed program. In this example, read “Samplel”.

Then connect online.

[t tor vaw it Re rooon Toob wndm 140
DEMh &R (s 0@ (%% 2R [[srE8a
Ao Q| [FEMERGE#Ew | —0BBEEL K

acx

EEFPROE 6205 0| L85 6
n o
£3

B rciCI ot
Y

|

©oo
& 0 Furden ks
02 poheie 51

P/

7]

M
T P ot 3| 5 e

Pt et

00,0 - 100%

2. Select verification.

Compare Options

3. Display the verification result.

&% Compare Result - [ Current Project - Connected PLC ]

Eile  Wiew

Compare

[tk tor vow v Ac_roon 1005 o 16
DEH (R & z

Slwineealame

EiEd)
61

I RARRIR(BTRE| L W %,

Fregiam Campare with PLC NewPLCT

sl

Transfeting programs.
Byte 3368 of E608

Comparing..

=)

1
[_[O[x]

['Current Project] NewPLCL

[Connecked PLCT

HewProgram? (00}

HewProgrami (00}

B section] B3 Section (1)
B3 Section (2)
0“
KN | KN rel |
For Help, press F1 [ same | DIff | Moved m 4
0‘.
You can check ladder contact
address differences.
.

In addition, you can check add,
delete, and move contacts, coils, and

apply instructions.

I 8 b
o ho el o
SR
g o o
mon ooy ol o
) e G
**** o, )
an
=
« 25
AR vt 1) 21 0 R (i B
e it T 7

CX-Programmer ¥5.1

@ Compare Failed

You can check FB parameter

differences.
)
&% Compare Result - [ Current Projes Connected PLC ] [_ 1O =]
File Wiew s
Y
Fl&| @ Cverview : “
a—
[Current Project] NewPLCL » w[Connected PLC]
NeveProgrami (00) : Sectiont ® | [PMewProgram1 (00) : Section (1) ]
GnGAG LD AT LD 000 LG, 60 :
00001 |£ND WW10.01 n 08001 [AND W 0.01
00002 |OR W10.02 " 00802 [OR W 0,02
00003 | ANDHOT 10,03 " 00803 [ANDNOT W10 03
( 00005 | ANDNOT Wi 05

o0 |LD CF113 0000ER{LD CF113
00bs |FECALL 415 00007 FBCALL 815
#0008 |FB_INPUT 80 00007 [EB_INPUT &0

00003 |FBLINPUT 21 00007 (RE_INPUT &1

* 000003 |FE_INPUT w10.02 00007 (FEB_INPUT V10,02
o poooos |Fe_NPUT 82000 00007 (FER INPUT 22000

00005 |FE_INPUT £2000 00007 [FENPUT &2000
00005 |FE_OUTPUT ¥10.03 00007 (FBUTPUT 141 0.03
00108 [FE_OLTRUT Wi 05 00007 |[FE_OUTRUT 140,06
00008 |FEERD 00007 FBEND

e — e
AR TR P O e
« il | ey

For Help, press Fi !\ Same | DIf  [Moved }_




Start-Up /
Adjustment On-
site

Unit
Parameter
Change

Program
Modification

Unit Parameter Change and Verification

After modification on-site, you can verify it with the designed Unit parameter and display the
differences graphically. This allows for easier checking of the parts modified on-site.

1. Read the designed program. In this example, read “Samplel”.

Then connect online. (If you have already read it in the previous section’s operation, this is not

required)
Click [I/O Table/Unit
Setting]

Open the I/O Table/ Unit setting, then double-click the AD Unit.

P BLELD e NemoLes S
Fle Edit View Options Help
7 cm-cPu13 Displayed Parameter YFEEEE ‘
‘@, Inner Board
£ [0000] Main Rack
4§ 00 [0000] CI1W-ID211(DC Input Uni) ] G Wi =
- 5 01 [000L] CHW-0C21 1(Relay Output Unit) M) 1SR AR W G Enable
Double-click the . T e Sty Disabis
g q ; Input3 Input signal use setting Disahle
regIStel’ed AD Unlt ) 04 [1500] C1w-DRMZ1(DeviceNet Master Unit) (Uit : 0) Inputé Input signal use setting Disable
0515251 Caw-CLkz1(Controller Link Unit) {Unit : 1) Inputs Input signal use setting Disable
?‘ 06 [1575] CMW-SCL41-¥1(Serial Commurnication Unit) (Unit : 3) InputB Input signal use setting Disahle
5 07 [000z] Empty shot Input? Input signal use setting Disahle
5 o8 [0002] Empty Slat Inputs Input signal use setting Disable
5/ 02 [0002] Empty Slat Input! Input range sefting 1-5v/4-20mA
4, [0002] Rack 01 Input2 Input range sefting 10V
Inputa Input range seffing w10V
CIMCPOI [Program Y Inputd Input range sefting +H10V
Inputs Input range sefting w10V
Inputé Input range seffing +H10V =l
I
= =l
= =l
Transferlrit toPC] | TransferPC to U] Compare n Beset |
Click [Compare] button X 4
Set Defauits oK | Cencel

2. Click the [Compare] button.
Now you can see the difference between the designed Unit parameters and the configured
parameters in the machine.

[Comparing parameters

Edit Parameters

ICompare ursuccesshul [2 mismatches)

*

.

You can check the
number of unmatched
items.

Click Cloze |

3. Unmatched detail differences can also be checked.

C11w-AD0B1-V1 [Edit Parameters]

Unmatched items are
shown in orange.

Displayed Parameter [All parameters

I~

s
[ 4 *

s
Le® o

Itern Setvalue Read value (Comp: &
Input! Input signal use seffing Enable Disable . *
InputZ Input signal use seffing Disable Disable o
Inputa Input signal use seffing Disable Disable o
Inputd Input signal use seffing Disable Disable o
Inputs Input signal use setting Disable Disahle *

. 5 *

Inputt Input signal use setting Dizahle Disahle »
InpuUt7 Input signal use seffing Disable Disable o
Inputd Input signal use seffing Disable Disable o¥
Input! Input range sefting 1-54-20mA A0V
INputZ Input range setting +H10Y +H1OV
Input3 Input range setting H10Y 10V
Inputd Input range sefling AT 0V
Inputs Input range setiing AT 0V

I I After checking the
unmatched details, Unit
parameters can be easily
modified.

b

.-“““L‘I

-
' Transfer(Unitto PC] | Transfer(PC to Urit] ! Beset

Set Defaults oK Cancel

You have now completed Chapter 2: Example of PLC System Construction by CX-One.
The next chapter describes PLC network construction flow.
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Example of PLC Network System Construction by CX-One

Workflow in This Chapter

This chapter describes an example of PLC network System construction from start-up to reassembly and on-site

adjustment as shown below.
This chapter mainly describes how to start up the System using CX-Integrator, an integrated start-up Support

Software for various PLC networks.

Adj. On-site >

* Describes details from assembly and wiring of PLC
System to program download for a trial run.

 Target of Start-Up

Aims at removing the cause of errors from a PLC
and to turn off all of red LEDs that indicate errors for
any component of the PLC System.

» Saving the entire system configuration after
completing start-up is recommended. You can utilize
it for system adjustment on-site after delivery to
reduce the adjustment period.

System Configuration

CX-One

Connection Cable
CS1W-CN226
(2m)

7

Connection Cable
XW2Z-200T

NS Series PT

NS8-TV00B-V1
System Version 6.0

or later

Start-Up > Delivery
T [ \
pLC DeviceNet NT Link Controller CompoWay Saving ! Eq_wpm’ent AN System Controller
Start-U Start-U Start-U Link X startup /| System )1 Disassy/o 2 Config. Ll
p p p Start-Up p Config. | _Reassy / |Verification Diagnosis
Start-Up Adj. On-site

» Describes details from disassembly of a system for
which the trial run, delivery, and reassembly on-site as
well as operation check have been completed.

¢ Target of Adjustment On-site

1) Confirm that no error will occur in its electrical
system in the same system configuration as that
before delivery.

2) Confirm that no discrepancy will be found in
Controller Link network settings by connecting to a
network on-site.

CJ1W-CLK21-V1
Unit No. =1Hex

CJIW-DRM21 Node Address =01 clwoRMa:
Unit No. =OHex Termination Resistance Node Address =04

Node Address =01
Other Settings = Default

CJ1IW-AD081-V1

Setting =OFF

CJ1W-CLK21-V1
Unit No. =1Hex

CJ1IW-SCU41-V1
Node Address =02

Unit No. =21 Unit No. =3Hex
Termination Resistance ~ CJIW-DRM21
CJ1w-ID211 Setting =OFF Unit No. =OHex
Node Address =05
PLC1 PLC2 PLC3
CJ Seri PLC\CJ1M-CPU13 CJ Series P 1G- CPU45H CJ Series PLC CJ1G- CPU45H
\ 1 NN 1 CJIW-CLK21-V1
o8| 8 o8| & Unit No. =1Hex
] O I 0Ol Node Address =03
0 Termination Resistance Setting =ON
0 5.8 4018 0 il

CJ1w-0C211

.

:

+ CJ
.

.

o Setting

Routing Table
(Local Network Table )

Unit No. =2Hex

E5CN-CQ203T-FLK
Unit No. =1

| ﬂ E5CN-CQ203T-FLK
Unit No. =2

I 125%&‘3590 I DeviceNet Network Address = 4
Use at

man [T ookesee |
| |

1W-NCF71 Compoway/F Network

\DeviceNet Network Address = 3

Unit No Network
T ‘| Address I/0O Relay Terminal 1/O Relay Terminal [T] [T]
1 : —
2 2 DeviceNet_Network Address = 2 1/0 Relay Terminal 1/0O Relay Terminal

Note) The Local Network

Table is requ

attach more than one

network com
Units.

Servo Driver f
REED-WNOLLML2 [T 125K b'tS/STC

1/0 Relay Terminal 1/0O Relay Terminal

Use at I

ired in order to

munications




Controller

PLC Network PLC DeviceNet NT Link COEitrr]?("er CompoWay SS;SVIE% Link
Start-Up Start-Up Start-Up Start-Up Start-Up /F Start-Up Config. Diagnosis

PLC Network Start-Up

Online Connection to PLC (Automatic Online Connection)

1. From the [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Integrator] > [CX-
Integrator] to start CX-Integrator. (Or select [All Programs] > [OMRON] > [CX-One] > [CX-

Integrator] > [CX-Integrator])

Starting CX-Integrator

iR » Integrator

Version 1.0

Project
10 i

=3

CX-Integrator starts and automatically connects online.

(Important)

This operation is used for online

Click % ----"'ﬁ"l-ﬂﬁ-%-ﬂ-f*ﬂ-h- H-&-‘%I i, “ EEiNE connection to any PLC hereinafter.
Unless described otherwise, use

R E S E»>BAEFSEE this operation to connect online.

nsert MWetwork Component Tools  Windows Help

Auta Online x|

Goes online automatically.
Select connection type and press [Gonnect] button,

—Gonnection type
& Serial connection(including the case when using USB-Serial conversion

Select a serial port. o Sarial
When USB conversion cable (CSIW-CIF31) , et

is used for connection, specify the COM port ~*7**={ e =)
number of the USB port used. P —

It will be: connected with the PLG connecting to the PG with the serial cable

Select a serial port, ... utomaticaly
then CI|Ck [Connect] "tEwagg, "raua, It iz not possible to use it for the Compoliay/F device,
"Trawgg,, "raaaa, Supporting PLO:CS/CJACP series
llllllllll..
LE

Cancel

IE
”nwu\gm\yﬂre\nruﬁmﬁ P |
2 35 2 CERR A P LY Y

L=== All communications Units and ports of
a connected PLC are automatically
displayed in the online connection
information window.

P PO okt
e T R o) Mo i o

e En ST N, o )




PLC Network Controller

. I
] g Saving ] \ System Controller
RURIS oo { Stnup 4 StutUp 4 UK JiRStnupy Sysem J jj  Config. 1 Link
Start-Up Config. ' 4 Verification & Diagnosis

Checking PLC Error

CX-Integrator

Ertors are inspected in the karget PLC,
Please check the content of the errors by "Display E&rror Log" before executing Online Functions.

(1) Remove the cause of the PLC error, then make it available to run.

J 3] Met[0), Mode(0]
Move the cursor on the isss== i

PLC and right-click

Select [Error Log]

Skart Routing Table

(2) Check the PLC error.

Examples of 10 settings error and CPU Bus Units and Special I/O Units number overlap error
are shown below.

Fx PLC Errors [_ 5] ]
Ele Options Help
Enors | EnorLog | Messages| You can check an error in a CPU

len  [Code [ Gtaws | Deals ] Unit and error history.

v (You can use the same function in
the error history of CX-Programmer’s
online screen)

|cim-cru1z Run |Clock: Mot Monitaring

=

(3) Solve the cause of error.

You must solve the problem through the following procedure:
- Set the PLC to PROGRAM mode (in which you can change settings).

- Change the rotary switch of the CPU Bus Units and Special I/O Units (make sure
that it does not overlap).
- Create the I/O Table.

* Set the PLC to PROGRAM mode.
From step (1) above, select [Mode Setting] then [Program] mode, and click the [Set] button.

=

L=l

Error Log

Start Routing Table

PLC Mode Setting [ x|

Node Addess: O CIM-CPUT3

i~ Fun I Set |
) Detug Read | Yo

Online Status: .

.
|M0de Command has been completed. Click [YeS].

Cloze

CX-Integrator

Please confirm there is no problem even i stopping PLC execution.Is it OK to change to
Stop/Program Mode?

" Monitar




. I
PLC Network : : Controller Saving ] \ System Controller
RURIS oo { Stnup 4 StutUp 4 UK JiRStnupy Sysem J jj  Config. 1 Link
Start-Up Config. ! 4 Verification Diagnosis

« To change the Unit number change the rotary switch of CPU Bus Units and Special I/O Units

and restart power.

CU21-V1
RUN ERC SD1 RD1
o o a ag

a o a a
RDY ERH SD2 _BQ

¢ Check if any error occurs in the PLC (CPU Bus Units and Special I/0 Units number overlap

error should be solved).
_I [SE g Ornline TDDIbus COM1,9600,Mone 8.7 [CJTh- CF'U13] Net(0]. Mode(0]

Skart RBouting Table

* Create the 1/0O Table.

| =3 Online Tool M1
v

CJTM-CPUIT3] Net[0), Hode(0]

Mode Setting

CPLU Port [CJTM-CPLUT

Start Rnut\ng Table

FME Edit Wiew | Options Help
CIIM-CP Transfer to PLC
@y Inner Bo. Transter from the PLC
y [o0DOD] ™M Compare with PLC

VY e —

Verify

Delete

Hot: Syap

Rack/Slot Start Addresses
Units Profile information
Dip Switch Information
Change ETHZ1 Made
Consumption and Width

Start Special Application ¥
Compare with Praject
Check.

Create Registe[CJIM-CPU13  [Program 4
T | PLC 10 Table H=]

Fle Edt View Options Hslp

[+, Inner Board
£-&j7 [0000] Main Rack
“ 3 00[0000] C11W-1D211(DC Input Unit)
-4 01 [o00t,
% o0z[zz210
-3 03[1550
Lo 041500
g os[1525
g 061575
7 07 [0002] Empty Slot
i g) 08 [0002] Emphy Slot
7 09 [0002] Empty Slot
-4y, [0002] Rack 01

CIHW-0C21 1(Relay Output Uit
CIW-ADOS1-¥1{Analog Input L
CIIW-NCF71{Position Contral L
CIIW-DRM21{Devicelet Master|
CI1w-CLkzt{Controller Link Uni
CIIW-5CU41-¥1( Serial Communi

| | »
[caam-cpuiz [Program v

» Check if any error occurs in the PLC
(all errors should be solved).

%] {8, Orline T aolbus COM1.9600 None 6.1 =1L CF‘U13]Net[U] Nade(0)
L Terget PLL (LI M-CPU1 3] Mt B
*. 3%, CPU Port [CHK-CPUT

10 table

Start Routing Table

s PLC Errors
Fle Options Help

[_ [T

Enors | Evror Loa | Messages |

Item Code

0<B0ED

Status
Fatal

Details

D01

0 Sefting Error

[cam-cP1z |Run

|Clock: Mot Manikering

7 j PLC 1D Table
Fle Edit WView Options Help

[ O[]

¥ CiM-cPuL3
(¥4, Inner Board
&, [0000] Main Rack
[+]-4ug, [0000] Rack 01

& -

[Cam-cPUE [Run

A

PLC IO Table

& Are you sure you want ko create the 10 Table 7

Ya, -“

Click [Yes].

PLC IO Table

& Initialise CPU Bus settings *

Create Registered 10 Table

Transferring.

The I/O Table is created and
Unit configuration is displayed.

=

File Options  Help

"
Ex PLC Errors [_ o]

Evrors | Eror Log | Messages |

ltem [ Code [ Status

[ Details [

DN Erors

[catm-cPUL3  [Program

[Clock: Mok Manitaring




PLC Network
Start-Up

PLC
Start-Up

Re-connect to a PLC
with CX-Integrator

Move the cursor on the
PLC and right-click

Select
[Start Routing Table]

Right-click and select local
network (Unit) [Insert CPU
SIOU] or local network (port)
[Insert PORT]

Enter its local network

number, then click [OK]

Reconnecting CX-Integrator

5 I
DeviceNet NT Link Controller CompoWay Saving ! | System Controller
Start-Up Start-Up Link /F Start-Up System d J Config. Link
Start-Up Config. ! 4 Verification Diagnosis

Confirming the Routing Table is not Configured

(1) Check that Routing Table is not configured.

x| EIQl Orlire T oolbus COM1,3600,MNone 8,7 [CJTM-CPUT3] Met[0), Mode(0]
Bl T a1zt PLC [C11M-CPL1T3] NetiD), Nodsll]
=5, CPU Port [C1M-CPUT3[Net), Wgdel-), Uit .
= DevicaNet [CJTw-DRMZTTNe(2), Node(1), LFAON = 2510 Check Routing Table

2 Contrallr Link [CTw-CLK21] Net(1) Moottt Uni)  PrESence. If the Routing Table
is not configured, create one.

g SO Port [CJ1-SCU41 4 | FEtT, Model-], Uritf3)

=

e R A L
Iy Devicel  ErrorLog
Mode Setting Mode(1], Unit[1]

odel-]. Unit[3]
Start Routing Table

v PLC Routing Table [_[O[x]
File Edit Options Help

M EE e

-4 CUM-CPULS A -
gy LNk 00
gy Uit 01
g, Ut 02
g, LNt 03
gy LNk 04
gy U 05
@y Unt 05
g, Unic 07 2
gy LNk 06
gy Uit 09
‘g Ukt 10
4 Unt 11 ]
gy Unit 12
gy Uit 13
g Nk 14

- e 1} 15 = &
T _"_I J | _"_I

~ 510U [Wetwerk ] " Mainiew [[Dverview | TableView |
|catm-cPuLa

=

(3) Edit the Routing Table and transfer to [PLC].

o1 (23|46 |6|7[8])910{11)|12[13]14[15

[etwork:0 Node:0 [Pragram 2

Enter SIOU Details
Insert CPL SICU ——— F =
Insert PORT Local Netwark Number [T =)

Cancel

Set the Routing Table as shown below:
« Assign a network number to a Unit number.
A Unit number can be checked on the online information window.
« Assign a network number to each network.
The Controller Link network number is same for other PLCs.

(4) Check if the error is solved.
* Re-connect to the PLC.
« All errors should be solved and no error messages should be displayed.
* The network number is displayed on the communications Unit.



\
PLC Network : : Controller Saving | \ System Controller
URIS ilp  Swnup 4 StatUp 4 <K JiEStnupy Sysem 7 i Config f _Link_
Start-Up Config. ' 4 Verification & Diagnosis

DeviceNet Start-Up

Remove DeviceNet communications errors and establish communications.
= Check DeviceNet Unit's 7SEG indication and ON state of MS/NS LED.
= Check Slave Unit configuration trough CX-Integrator.

Create a scan list of DeviceNet and determine the memory map.

(1) Connect to PLC online, then connect to DeviceNet through the online connection information
Right-click a DeviceNet window.
U Ly Taugiet Devies 2 (={M)] Onine T oolbus COMI 5600 None 2.1 [CJ14-CPL13] Net(0), Nods(0)
in the online connection N
information window, then
select [Connect]

'j_:?_| Enntrollerl TransFer[Netwurk b PC]

feodm SCU Port [

Stark Data Link:
Stark Routing Table

=

(2) Next, upload the network configuration information of DeviceNet.

:|I =- . Onling Taalbus COMT,9600 Mane 8,1 [CHK-CPUT 3] Het{0)], Nade(d]
u] TocetPLE )

- ContrnllerL ansfer[h 0 ,U|[1]

<& SCU Port hit[3
== I Conneck )
Start Data Link
Start Routing Table

CX-Integrator [ =]

Metwork structurelMebwork Mo, :2) wil be tranferred.
Please transfer the netwark parameter for each component if needed because they are not transfered here (in the

case of Controller Link and SYSMAC LINK).
Da you wish ta continus?

In this example, although one Master Unit (node number #01) and two Slave Units
(node number #02, #03) are actually connected, assume in this start-up example that
one Slave Unit (#03) is not connected due to disconnection.

(3) After transfer is confirmed, connected devices on the current DeviceNet network are
displayed as shown below.

ow N1 (DeviceNet) GO02) Mi=] [

= e

#01 #02
C1W-DRM21T  DRT2-ID16+X0..

o I ;

g . .
*+ Check if a Slave device on the remote 1/O
communications actually wired is

recognized. Master Unit (#01) and Slave
G Unit (#02) are recognized, while another

Slave Unit (03) is not recognized.
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Start-Up Start-Up

Right-click on the Master
Unit icon and select
[Monitor] to display the
device monitor screen.
Select [Status] tab

Perform the step (2) from
the previous page

Double-click a Master Unit
(CJ1W-DRM21) icon

=
=

Click twice

—J
=

C|IC|( the [OK] buttonlll--.l--llll:badllﬂiﬂﬂ"idnqéﬂ EE'IEJ

Right-click the Master Unit
and select [Parameters] >
[Edit]

=
=

Edit the parameters, then
click the [OK] button

Select [Network] >
[Transfer [PC to Network]]

- I
DeviceNet NT Link Controller CompoWay Saving g | System
Start-Up Start-Up Link /F Start-Up 4 System 4 )| Config.
Start-Up Config. ' 4 Verification

L)
L]
Tea, . W 3204:Ei08
"y
L]

Status | Ur taus | Comurication Gyl Tire | ity

(4) Check the error on the device monitor screen.

Controller
Link
Diagnosis

* Slave Status——3 *,
*

CCO@CCE -

000 0203 04 05 E CCaeco
WPV TV T PP G
Eidessossss sl

e
4041 42.43 44 45 45 47 43 4950 51 525354 55 56 57 58 59

Slave Unit (#02) is recognized, while the o

You can check the Slave status on
the device monitor screen as well.

N

other Slave Unit (03) is not recognized.

aaaan

amannn

U

(5) Wire Slave Unit (#03) correctly.

(6) Re-upload the network configuration information of DeviceNet.
!Iil

= Network1{DeviceMNet){#002)

Now it can be confirmed that Slave
devices on the remote I/O
communications have been recognized
and communications have been
established.

(7) Configure DeviceNet remote I/O communications (free assignment) and register the Slave
to the Master.

#01 #02 #03
CIIW-DRM21  DRTZ-ID16+xW... DRT2-OD16+h...

Communication Cycle Time | Message Timer | Slawe Function | Commurication Cpele Tme | MessageTimer | SlaveFunction |
Genersl | DAlocationiOUT) | 1/0 AllocationilN) Gereal | LOAocatoniOUT) | 10Alocatonit) |
Urnegister Device L Urregister Device L
# | Product Name [OutSis [inSize | # [ Product Name [OutSize [InSize |
&Mz DRT2DIERWTIDG R
UG DRTZODIERWTODIE iBe OBy

Two Slaves are now registered to the

Master.
EEEEEEEEEEEEEEEEEEEEESE N
- IE ¥ Auto alocation as is registered. W |y v aul slacstion a5 15 tegstered
- Register Device List - Register Device List—®
# | Poduc..| DutSze | OutCh [ InSize | InCh | C |
£p#02 DATZ.. OBy 4Byl 3300BiL..
£p#03 DRTZ.. 4Byie  3200Bi. OByte

Advanced Setup Register/Unregisterd Advanced Setup, FReaister/Unregisterd
llllllllllllllllllllllllll — | 2 | = |
ok Carcel i oK Cancel
(8) Configure assignment of Slaves to areas of a CPU Unit.
If necessary, configure the Slave parameters as well.
Edit Device Parameters
Communication Cycle Time | Message Timer | SlaveFunclion |
General 140 Allocation(IUT] I 1700 Alloeation(IN)
# Product... | Size [ Auta
| [E 20, 4 Byte 00 . . .
Delee <Master Unit parameter edit dialog box>
Edit
Information
~ Memory Block 1 - Memary Block
Ch [ Product Name [« ] Ch [ Product Name [
-

W 200ER00 HOIDRT2-
W 200ERDS HOIDRT2-
W 3201:BR00 HO3DRT2-
W 3201:BR08 HOIDRT2-
W 320200
W 3202Bi08
W 3203Bi00
W 3203Ei08
W 3204:Bi00

g Il |

.felﬂu'....

Senp.
LI}
a
g ok | cencel

(9) Start remote I/O communication.
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Right-click a CPU Unit
under a connection target
PLC in the online
connection information
window, then select
[Connect]

’ ] \
DeviceNet NT Link Controller CompoWay Saving ! | System Controller
Start-Up Start-Up Link /F Start-Up System 4 J Config. Link
Start-Up Config. ' 4 Verification & Diagnosis

NT Link Start-Up

Remove NT Link communication errors and establish communications.
= Release NS Connecting . . . message.
= Check NS configuration through CX-Integrator.

(1) Connect to PLC online, then connect to a CPU Unit through the online connection
information window.

(-], Unit[-]
. Wode[1], Unit{0]
1], Made(1], Unit1]
], Mode(-], Unit[3)

Stark Diata Link:

Stark Routing Table
MT Link Tonl 3
Controller Link Tool »

=

(2) Selectin the order from upper link port to NT link.

Selected ltem  CPU Part[252) : Serial Port Selected ltem  MTLink

Select the item from the follawing list. Select the item from the following list.

| EomEGWaiF

Cancel

' Cancel

=
<

(3) Next, select [NT Link Tool] > [NTLink Auto Online Setting] from the CPU Unit.

x| = Orili
1 - I

z COMT, 9600 Mone, 8,1 [CITM-CPUT 3] Net(d), Made{d)
58D 3] Net(0), Node(0)

LC [CITM-CPU 1] [1]]
CPUT3] Met-], Mode-], Unit[
Mode(1], Umit{0]

1]. Made(1], Unit[1)

, Model-], Urit[3)

Transter[Metwork ko PC]

Conneck

Stark Data Link
Start Routing Table

MT Link Tool MTLink Auto Onling Setking
Controller Link Tool

<

2]

Automatic NT Link connection function is used to automatically connect NS series PT
and PLC via serial connection (NT Link). Connection is automatically performed by
overwriting the PLC serial communication port settings by adjusting to NS series PT

settings.




_________ \
PLC Network : . Controller Saving | \ System Controller
RERIUS iUp  StnUp 4 StriUp 4 <K JiRStnupy Sysem i Config f _Link_
Start-Up Config. ' 4 Verification & Diagnosis

CX-Integrator
& Changes CPU the setting of RS-232C Port and then connects ta NS series PT.
Scans the Port Setting automatically until finding NS series PT,

If executing this procedure then CPU R3-2320C Park setting is ovenaritten,
Ensure that it is not connecting with this port then execute i,

Present setting: NT Link, Standard

Are you sure?

Click [OK] (E
< -

(4) Check the CPU DIP switch.
« Follow the on screen instructions to change the DIP switch.

CX-Integrator

@ Start communicating with NT series PT ko analize the setting automatically.

Ensure that Dip Switch 5 of CPU unit is OFF,
It is the setting to change From RS-232C Part ko MT Link.

Cl|ck[OK] EEEEEEEEEEEEEEEEEEEEE

(5) Screen message Connecting . . . is now cleared.

(6) Next, upload the network configuration information of NT Link.

2| == Orline Toolbus COM1,3600 Mone,

T =W cual 1 et PLE [CJ1M-CFU
Select Tk . .
[Transfer [Network to PC]] *====qF=="" Mode(1]. Unlt[';l]
11, Node(1], Unit[1]
. Niode(-). Unit[3)

1 [CITH-CPUTZE] Net(0), Made(0)

Conneck

Shart Data Linte
Start Routing Table

MT Link Tool [
Controller Link Tool 3
1| |+l
CX-Integrator

Metwork struckure{Metwork Ma.: Mone) will be tranferred.
Please transfFer the network parameter For each component if needed because they are not transfered here (in the
case of Controller Link and 5YSMAC LIMK).

Do you wish ko continue?

C||Ck[Yes] EEEEEEEEEEEEEEEEEEEEEEEEEEEEE

(7) After the transfer is confirmed, connected devices on the current NT Link network are
displayed as shown below.

. Network1_CPU Port_Serial Port{NTLink){-) H=] E3
-

Metwark1_CPU Paort_Serial Port[MTLink]

CompoZ

Compo1 e

S 1y B2
CJ1M-CPUT3 N3B-TVDO-T

HOOO

o |




Controller
Link
Start-Up

PLC Network PLC
Start-Up Start-Up

Saving
System
Config.

System
Config.
Verification

Controller
Link
Diagnosis

DeviceNet
Start-Up

NT Link

CompoWay
Start-Up

/F Start-Up

Controller Link Start-Up

Remove Controller Link communications errors and establish communications.
= ON state of Controller Link Master Unit's INS LED
= Check Controller Link configuration through CX-Integrator.

(1) Connect to PLC online, then connect to Controller Link Unit through the online connection
information window.

E =g E, Online Toolbug CORT,9600,Hone, 8,1 [CITM-CPUT3] Met0], Hode(0)

AT = coal et FLC [)1M-CPL1 2] Met{0), Nodei0]

----- j% CPU PortSerial Part:MTLink])[CJ1-CPU13] Met-), Mode(-], Unit[252)
----- -j'fj Dewc:eNet [EJ1W DHMEHNEl[E] Nu:u:le['l] Llnlt[EI]

Right-click a Controller || f-;. SEU F'Drt [DJ
Link Unit in the online

connection information
window, then select : SFavk Miaka linl

IEEEE NSNS NN NN NN N EEENEEEENEEEE N ;|:|r|r|E:|'|'

[Connect]
(2) Next, upload the Controller Link network configuration information.
x| EE, Orline Toolbus COM1,9600 Mone 8.1 [CI1M-CPUT3] Net(d), Hade{0]
T [ W sl 1 et PLC [CI1M-CPLIT3) Net((D], Nodz(0)
iy CPU Part [CJ1-CPU13] Net-), Mode-), Unit-]
-l,fj Dew:eNet [DJ'IW DHM2'|]Net[2] Nu:u:le[‘l] Llnlt[D]
Select o C. (1 b odel
[Transfer [Network to PC]] == === ﬁ SEtFPan rgﬂ

Connect

Skark Miaka linl

=

Transfer[Metwork[#001] to PC] |

Pleaze zelect the tranzferred data, and press [Transfer] button.

™ Metwork structure only

%" Metwork structure and Parameters for each component

Pleaze transfer the network parameter for each component it
needed because they are not transfered here (in the caze of
Contraller Link and SYSMALC LINE]

Cllck[Transfer] --------------------------------‘ Transfer Cahcel
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Select

[Transfer [Network to PC]] '®=="ff="=""""

Click[Transfer] NN EEEEEEEEEEEEEEEEEEEEE I Cancel

5 I
DeviceNet NT Link Controller Compoway § Saving Ny System
Start-Up Start-Up Link /F Start-Up EET )y Confio.
Start-Up Config. ! @ Verification

(3) After the transfer is confirmed, connected devices on the current Controller Link network are

displayed as shown below.

— Network2{ControllerLink){#0013) H[=]
Metwork2 [Controller Link] (#001) -
Compo3 Compod
CIM-CPU13 CG-CPU45H
HO01 HOo2
P ! 4
=]

In this example, although three PLCs are actually connected through the Controller Link,

in this start-up example explanation assume that only two PLCs are displayed.
(One PLC did not join the communications due to incorrect Routing Table settings)

=

(4) Check the Routing Table and configure it correctly.
See “Confirming the Routing Table is not Configured” for configuration details.

(5) Re-upload the Controller Link network configuration information.

%| =@ Orline Toolbus COM1 9600, None 8.1 [CITM-CPUT 3] Metl), Mode(d)
Al [SREte T 5rget PLC [C)1H-CPU13] Met{l), Node(0)

----- <& CPU Port [C1TM-CPU13] Met(-), Madel-). Unit-]

----- -.1'.- DewceNet [E.J'I'W' DFIM2'|]Net[2] NDde['I] Unlt[D]

Cannect

Tkavk Miaks |inle

=

Transfer[Metwork[#001] to PC]

Pleaze select the transferred data, and press [Transfer] button,

" Metwork structure only

% Metwork structure and Parameters for each companent

Fleaze tranzfer the network, parameter for each component if
needed becauze they are not ranstered here [in the case of
Controller Link and SvSaC LIME).

=

(6) Send the network configuration from the network to the personal computer.

— Network2(ControllerLink}{#001) H=]
Netwark2 [Cantraller Link] [HOO 1] -
Compod Compod Compas
CJ1h4-CPU13 CJ1G-CPU45H CJ1G-CPU45H
HOO1 #oo2 HOO3
N 1 [
=
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Start-Up Start-Up

Right-click an SCU port in
the online connection
information window, then
select [Connect]

(dd

Select SCU port (140)

(dd

Select CompoWay/F

Right-click an SCU port in
the online connection
information window, then
select [Transfer [Network
to PC]]

{

Click [Yes] in the message
dialog box

(e

Select [Selection], enter
1 for minimum and 2 for
maximum values, then
click the [OK] button

5 I
DeviceNet Y| NTLink Y C°iIOHeT Y compoway - S24T9 § R
Start-Up Start-Up Start-Up /F Start-Up Config. i / Verification

CompoWay/F Start-Up

Remove CompoWay/F communications errors and establish communications.
= Check CompoWay/F configuration through CX-Integrator.
= Configure serial communications Unit parameters.
= Configure temperature controller communications.

This example explains the start-up of a serial communications Unit with two temperature

controllers (E5CN) connected via CompoWay/F.

» Two temperature controllers (E5SCN) are connected to serial communications Unit
(CS1W-SCU41-V1) port no. 1 via RS485. Communication Unit numbers are #001 and #002.

« Communication settings of the serial communications Unit and the two temperature controllers are

unmatched.
« Communication settings between the two temperature controllers are unmatched as well.
(1) Connectto PLC online, then connect to a CPU Unit through the online connection

information window.
_I =- . Online Toolbus CDM‘I SBDD None 8.1 [CHM-CPU13] Met(0), Mode(0)
M et(0), Mode(0)

£

TransFer[Network e} PC]

Connect:

CX-Integrator E

Selected ltern  Compa'wayF

CX-Integrator E

Selected ltem  SCU Port[140] : PORT1

Select the item from the following list.

Select the item from the following list.

' Cancel |

P
-
v

' ok I' Cancel |

i
*
*
]

i :
click Click

(2) Upload the CompoWay/F network configuration information.

_I E1-/™ Orline Toolbus COM1,9600 Hone 8,1 [CHM CPU13] Met(d), Node(0]
[ER="2] Target PLE [CIM-CPLITE] . Node(0]

= CPU Port [CI1M- EPU‘IS]Net[] Node[] Unit[-]

-.Jf.— DeviceMet [CI1Ww-DRM21] Net{2], Nade[1]. Unit[0]

— Controller Link [T/ ELK21]Net[1] Made(1]. Urit[1]

SCU Port[POR |.. i CL4147] Metl-]. Hode(-], Unit[140]

Conneck

Select finding node range.

" Al0-99)

Controller
Link
Diagnosis

Compoway,/F Finding node se...

CX-Integrator

Metwork struckuredMetwork Mo, None) will be tranferred,
Please transfer the network parameter For each component if needed because they are not transfered here (in the

case of Controller Link and SYSMAC LIMK).

&+ Selection

Min |1_ Man Ia_
It will take bwo seconds or less per
%

Do you wish ta continue?

Cancel |

Click B
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PLC
Start-Up

Click [OK]

Then click the [OK] button

in the d|a|()g box indicating "lI------------------.-------------

completion of transmission

Place the cursor on CJ1M-
CPU in the [Network
Structure] window and
double-click

=

From the menu, select

[Component | Mode Setting]

to display the [PLC Mode

Setting] dialog box

(1) Select [Program] for
operation mode

(2) Click [Set]

(3) Click [Close] after

changing
=

From the [Display
Parameter] pull-down menu,
select [Portl: Serial
Gateway Settings]

.

=

Click [OK] in the [Edit
Parameters] dialog box and
close the dialog box

Perform the step (2) in the
previous page

Click [OK] button in a dialog
box indicating completion of
transmission

NT Lin
Start-U

DeviceNet
Start-Up

CX-Integrator

Ty
-......
LR ]

k
p

Controller Saving | \ System Controller
Link %) rgtpa?t_V\Giy System > Config. Link
Start-Up P Config. ' 4 Verification & Diagnosis

& Cannot aquire the Slave node.

This dialog box is displayed because communication is
not established between the serial communications
Unit and temperature controllers.

Cx-Integrator

@ The parameters were transferred

(3) Adjust the serial communications board parameters settings to those of the CompoWay/F.

o = Network2_Unit(3)_PORT 1{CompoWayF)(-)
Metwork2_Urit[3]_PORT1 [Compo'iayF)

.
*ay
*a
.

Compod

CJIM-CPUT3

1= E3

The [Network Structure] window
shows a CPU Unit (CJ1IM-CPU13)
that has a serial communications
Unit, but neither of the two

temperature controllers.

=
PLC Mode Setting B3 |
ode Address: 0 CJIM-CPU1Z
()| ——
& ogat Can YL o2 | @)
-
‘.-" l " Monkor {7 Debug Read . .
et — ——— | Configure [Portl: Port settings] to [Manual]
I”;";Ei‘a‘“& — — and [Portl: Serial communications mode] to
ode Command has been completed. . .
) © [Serial Gateway]. Check other settings as
LClose .
well, and change if necessary.
L]
C114-5CU41-¥1 [Edit Parameters] ]
Displayed Parameter [Porll: Seiial Gateway Selings | D\su\ayeﬁ.:alamelelanm Serial Giatewap Settings |
- {0 N
Y L wem | Getvawe | Unt o —— e N
. Fort1: Port seftings User settings Port: Port settings User settings
Portt: Serial communications mode | Serial Gateway Portl: Serial communications mode | Serial Gateway
Fori: Data length 7 hitz Port1: Data length 7 bits
Port1: Stop hits 2 hits Porti: Stop bits 2 bits
Port1: Parity Even Porti: Parity Even
Portl: Baud rate D Portt: Baud rate D
Port: Send delay Default (0 ms) Porti: Send delay Default (0 ms)
Port1: Send delay (user-specified) o ms Portl: Send delay {user-specified) 1] ms
Paortl: CTS contral Mo Portl: CTS control Ma
Fort1: Response timeout ti 0 ms i .
Click the reset button to
enable settings. Click [OK]
in the reset confirmation
) = || | <D faults Host Link{defaut] Al : a IMESEER dlaIOg box.
<hddressyWard:D30300, Bit:8-11 <hddressy\Word D 30200, Bit8-11
<TypesList «TypesList
= = =] L]
TrarsfeUricto Fel | TrensefPCroUri] | Compare | Besst TrarstoUricio PEIfl TrarsiofPC ounin [J 4 ’( = |
Set Defauts Lancel Sel Defaults [
Confirm that settings are correct, then select the
[Transfer [PC to Unit]] button. Click [OK] in the
transmission confirmation message dialog box.
Select a port to reset from the lizt below
@ The unit was reset
Select

[HOSTLINK1]
and click [OK]
button.

.
.

‘e

‘e

g
-

.. L]
g (I Gick

(4) Re-upload the network configuration information of CompoWay/F. Perform the step (2)

from the previous page.

=

Only the Units for which connection is established are displayed in the [Network Structure]
window, as shown on the next page.
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Start-Up “SartUp anTir%IGIE Link 2S00y 4 System )| Config. Link
Start-Up Config. ! 4 Verification & Diagnosis

. Metworkl Unit(3)_PORT1{CompowWayF)(-) =l

Netwwork1_Unit[3)_PORT [Compoiayh

-

The [Network Structure] window
shows only the Units for which
connection is established, and Units
with incorrect communications
setting are not displayed.

=1

(5) Check the settings of the temperature controller that is not displayed in the [Network
Structure] window (baud rate, data length, stop bit, parity, Unit number), configure it correctly,
then re-upload (Perform step (2) from two pages ago). The [Network Structure] window is

Check the temperature
controller that is not
displayed properly and

. . updated.
configure it correctly

b Metwork1_Unit[3]_PORT1[CompaayF] - I

l:j Compal Now the correctly configured Unit is

... displayed and you can confirm that
ﬁ communications settings are correct.
Perform step (2) from two BRI 9
pages ago
[

I:j (6) Move the cursor on E5CN of communications Unit number #002, then select [Start Special
Application] > [Start with Setting Inherited].

. Networkl_Unit(3)_PORT1({CompoWayF){-) - O] <]

Metwark1_Unit[3)_PORT1[CompaayF]
a a [m]
Compal Eegeed J

Compo2

CHM-CPUT3 igg:‘ 25 Cg’ Barameter
Right-click on the : = “‘?f  Toogle Poston
communications Unit & f:;\; E:'I:i
number #002 icon inthe ., Delete

[Network Structure] window,
then select [Start Special
Application] > [Start with
Setting Inherited]

Edit Mame. ..
Edit Mode Address

(6) Dedicated Support Software CX-Thermo is started with the same model and setting as
that of the temperature controller.
After parameter settings are finished, download the settings to the ES5CN of
communications Unit number #002.

) €%-Thermo [_[C1x]
After parameter Setﬂngs File(E) CommunicationstCy View() TrendMontor(T) Option(Q) HelpH)
are finished, select Jj:‘"““‘“ 6 —
[Communlcatlons] > CH Chennel-1 Parameter Name: Set Point
[Downlqad to Device], then st 010
select either [Download all], S mm ]| - — —
[Download Changed & S [z
et Foint
Parameters], or [Download IS amvabe |
Alarm Upper Limit Value 1 Factory default Iu—
Changed from Default] B st mivate!
gi?"’gfili (I |ﬂ— Reset odit
r[B) m pper L vee 3 St the recuired temperature o)
=] \usstFr’vE'Ent level
2L =l

[DLI21105 124431] [e5cn] is Jounrhed from CX-Infegrator in the O line state.
[DL/21/05 12:44:41] The setting of e on-RT begins

(Confinming the connection.

"Device being edited novw” is NOT ronesponding to "ronngoted Devie”
[DL121105 12.44:51] The setting of eSon-CQI0IT-FLK begins.

Uit surber(12] On line

I S
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Saving System Configuration (1)

Save the system configuration for inspection after delivery.

(1) Connect online to a PLC on a network.
The online connection information window is displayed.

x| =@ Onlire Toolbus COM1.! BEDD Mone,8.1 [CJTM-CPUT3] Met(D). Made(0) H H i
T o T All communications Units and ports of
, Hodel, Unitt] k==ax g connected PLC are automatically
-y Devicelat [CITW-DRM21] Net(2], Mode(T). Urit[0) R R R A
-j'g Contraller Link [CJ1w-CLE2T] Met(1], Mode{1], Urit[1] qlsplaye.d in the On“ne Conne.Ctlo.n
25 SCU Port [CITW-SCU41 V1| Net(-), Nade{], Unil[3) information window. From this window,

connect to each network and save the

’ configuration to a project file.

(2) Send the network Structure of DeviceNet to the personal computer.
Connect to DeviceNet from the online connection information window. After connection
is established, send the network Structure of DeviceNet to the personal computer.

ES @, Onling Toolbus COM1.9600.M

Move the cursor on the
DeviceNet and right-click

8.1 [CJTM-CPUT3] Nel(D), Node(0) 2| -] Oriine Tookus COM1.3600 None 3.1 [CI1MH EFUTE]NeI[D] Nods(0)

A E@

Select [Connect] 1@ Contioler Lmk [CITw DLK21]Net[1] Nor

Transkerietwark ta PE]
s e (B EC U Ul Node pars

Select e .
[Transfer [NetWOI’kto PC]]-----------------------------------------------------------------------“

(3) Send the network configuration of NT Link to the personal computer.
l:j Select the connection menu on the CPU port, then select upper link port and NT Link.
|:j Next, select the transmission menu on the CPU port.
EI nine us & - Mol x| nline | oolbus ONE, el odel
2 =8 %&?\ Toalbus CIIk1 3800 Nane.81 [CJ1M-CRUIT3] Netl], Nods{0) jE‘ %__EE‘ Toolbus COM1 960 1M-CPL3| Netf0), NodefD)

. Node(
Contraller Link [CJ1W CLK21] Netﬂ ], Mac
Al i E) K} (N S

Select [Connect] ==ssssssanss

fg Controller Link, [CITW-CLKZ21] Met(1]), Mo
gl SCU Part [CJ14-5 004151 Netl-), Node,

gofinect
go®ict
Select TR

o** Start Data Link
Start Routing Table * [%e Start Routing Table
[TranSfer[NetWOfktOPC]]""""""""""""""""W"" EpsEErETETETEEEEEEEEEEREES —_—
é )
Select
A n Selected ltern  CPU Port[252] : Serial Part Selected ltern MTLink
[Senal Port] > [NT L|nk] EEEEssssEEsEsEEEEEEEEEEES
Select the item from the following list. Select the item from the following list.
Compiot/ ayF
CPU Part[253] : Peripheral Part
@ Cancel Cancel
I: j \ J

(4) Send the Controller Link network configuration to the personal computer.
Connect to the Controller Link network. After connection is established, send the network
configuration to the personal computer.

x = Dnlma Taolbus CDM1 9600, Mone, 8,1 [CJ1h- EF’LIWS] Net(0]. Node(0]

=k
m

= 0 s Tcolbus CO1,9600 None, 6.1 [CL1H-CPLIT3] Nell0], NocelO)
B C [CJ11M-CPU13] Net(d], Node(D

PU13]Net[] MNode(-). Unit{252) :r TP Part [uw EPU13]NE del-), Unit(]
Mode{1], Uml[D]

Select [Connect] =ssusass .....;;...............4..

Select SIS ‘
rrransfer [NetWOI'ktO PC]]-----------------------------------------------------------------------"
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PLC
Start-Up

Select [Change
connection to this PLC]

Select [Connect]

Select
[Transfer [Network to PC]]

Select [Save As...]

Controller
Link
Start-Up

Saving
System
Config.

Controller
Link
Diagnosis

System
Config.
Verification

NT Link
Start-Up

DeviceNet

CompoWay
Start-Up

/F Start-Up

Saving System Configuration (2)

(5) Connectto a PLC on the Controller Link network.

Select a remote PLC on the Controller Link network configuration screen (a PLC without a
square symbol) to switch the connection destination to the PLC.

Destination PLC communication device configuration is displayed in the online connection
information window.

. Network3{ControllerLink){#001) =] E3

Network [Cortraller Link] (HOD 1] -] A Green frame is dlsplayed on
a
Compod Compod CompoS e
the specified remote PLC.
g T Parameter
a ]
Display Error Lo = i
. ErEaEl play Errar Log = Nebwork3(ControllerLink)(#001)
4001 a 2 StatusiError of Communication Unit Network3(ControllerLink) (40 =
J Error Log of Communication Unit . 2 3 7 . 5 J
ompo: ompe ompe!
Change connection ta this PLC, ﬁ ﬁ, ﬁﬁ
CJIM-CPU13 CJ1G-CPU45H CJ1G-CPU45H
#0071 HAO2 H003

M

Online Toolbus COM1.9600 Mone 8,1 [CITM-CPUT 3] NetD), Node(0)
45H] Net

o CPU Port [CI1G-CPU4SH] Netl-). Madsf-). Urit)]

T, DeviceNet [CIT1w-DRMET] Net2). Made(S). Unit(d)
Contraller Link [CIT4w-CLEZ1] Net(1), Node[2], Unit(1]

=
B

L2

All communications Units and
ports are also displayed in the
online connection information
window.

(6) Send the DeviceNet network configuration on the remote PLC.

Connect to DeviceNet from the online connection information window and send the
network configuration to the personal computer.
U1 3] Met{0], Mode(0)

La b

SEL ]
s

riline Taolbus CR1LSE00 None, 5,1 [CJM-CFLTE] Hetil), Hadef)
el T ~get PLC [CJ1G-CPUA ell1) 2

—
Conpey

+* Start Data Link.
.

Stark Data Link:

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIllllllllllIIIIIIIIIIIIIIIIIIIIIIIIIIIII‘

~

(7) Send the DeviceNet network configuration on another remote PLC.

Repeat the steps from (6) and (7). After transmission, all the networks sent to the
workspace are displayed.

| =

E!% MewProject
'E;IIEI Metwork1[DeviceMet|[#002)
~zie Metwork?_CPU Port_Serial Port{NTLink][-)

EE]

Metwark 3[CantrollerLink (#0071 )
-jf-d— Metworkd|DeviceM et [#003)
el MetworkS(Deviceh et)[#004]

Project

=

(8) Save all the configurations.

NewProject - CX-Integrator - [Network1

Chrl+M

D =
+— [ open o
Jtﬁ Close L 7
— & save Chrl+S
EEsssssssmemmEnnnnnnnnn i

02]
al PortMTL

Import... L3



Controller

PLC Network ; q Controller Saving
Start-Up Csalp 4 StarclUp 4 Lk AGEShnn 4 System Link_
Start-Up Config. Diagnosis

System Configuration Verification (1)

Confirm that the System has the same wiring and settings as before disassembly.
= CX-Integrator verification is complete.

(1) Connect online to a PLC on a network.
The online connection information window is displayed.
All communications Units and ports

fll = @, %\ms Toolbus CO| Th-CPUT3] MNet(0). Node()
1 [ER=s) 7arget PLC [C U el0)
CPU Port [CITM-CPU1 3 Hetl-). Hodel-], Uritl) mma ofa conpected _PLC are_ i
-+ DeviceN: [CHTW-DRM21] Net2], Node(1). Ui@) automatically displayed in the online
fg Cantroller Link [CI1w-CLEZ2T] Net{1], Node(1]. Urit[1] 5 a 2 A
connection information window.

=

(2) Verify the DeviceNet network configuration.
Connect to a target DeviceNet from the workspace and verify the network Structure.

=zl = =zl =
E-% E-% MewPioject
Hetworl [
Metwork Inisert Metwork:
Network : =5 Networl .
Network fegr Networl DElete
TransFet[PC to Metwark]
Transfer[Network to PC]
Se|ect[Connect] EEEEEssEEEEEEES
*
\d
——— *
Rename Metwork . .* Rename Wetwork
Change Ketwork address . “‘ Change Metwork Address
Se|ect[C0mpare] """""""""""""EoT:RQ)"""""_'"""""'""""_‘ comyic) |
Project Paste(R)

Project PastelP) |

(3) Any error found in the configuration verification will be displayed in the verification result
dialog box.

Comparison Result

e e o "—'j ve=nwaa Ifyou find a Slave that is not on
© Device Type of #05 is differsnt Cl1WwW-DRM21 It doesn't exist.

the network, you may have
incorrect wiring in the network.

Click [Close]

(4) After solving the error, verify the configuration again.

A message is displayed indicating
@ Ho diferences were found, verification matching and now it can
be confirmed that the configuration is
the same as that before disassembly.

Click [OK]
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PLC Network - : Controller Saving
Start-Up Comin. 4 Streip 4 oink  ZGPDRONGY 2 System Link
Start-Up Config. Diagnosis

System Configuration Verification (2)

(5) Verify the NT Link network.
Connect to the NT Link from the workspace and verify the network configuration.

Confirm that the same verification matching message is displayed as in step (4).

zlxl =l
E\--% NewProject = % NewProject
b gt N k1D evicetet|(HO0Z]
o : k2 CPLI Port Serial Forti!
o h = Metwork  Open
=5 Metwork % Network  Insert Hetwark
<oy Network “oozly Metwork -
Elete

Transfer[PC ta Netwark]
Transfer[Metwork to PC]

TEERRRRRY
PR i ——
.®
.® Rename Hetwork
sssssssssmmEnEngunns® Y

Select [Connect] =========

Rename Metwark
EEEEEEEEEEEEEEEEEEEEEEED

Select [Compare]  r======="

(6) Verify the Controller Link network.
Connect to DeviceNet from the online connection information window and verify the

network Structure.
Confirm that the same verification matching message is displayed as in step (4).
=l x| zlx
B--ﬁ NewProject = % h!emeia:l

fﬂr MNetwork1[D eviceMet)[#O02) Tfj Netwark1(DeviceMet[#002)
: = Metwork2_CPU Port_Serial Port{MTLink](-]

o Metwork  Qpen
Logp Metwork  Insert Metiwork

Delete

Transfer[PC ko Mebwark]
Transfer[Metwork ko PC]

Transier[fet
COmMpEre.

—————————————— . =
Reename: fetwork .
= I os® * Rename Metwork I

Select [Connect]

Select [Compare]

(7) Connect to a PLC on the Controller Link network.
Connect to a remote PLC using the same procedure as the step (5) for saving a System

configuration.
Use steps from (2) to (4) to verify the DeviceNet network.

= Network3(ControllerLink){#001) M= E3 .. Network3(ControllerLink)(#001)
- Network3[CeantrollerLink]

Network3[Contraller Link] (00 1]
=] a o
Compa3 Compad CompoS | Compal Compod CompaS J
s " Parameter T T T
o | o Fmm| ; Gam o | GEW
Display Error Log
CHM-CPUI3 CJ1G-CPL CJ1M-CRU CJ1G-CRU4SH CJ1G-CRU4SH
H#001 StakusjError of Communication Lnit H001 Hans 4003
Error Log of Communication Unit 1 I 1
Lot A
=

Select [Change CEEE

connection to this PLC] -

=@ Orline: Tookbus COM1,9600 Mone 51 [C1M-CPLI 3] Net), Node{0)
B- L [C) 45H] Net[1), )
= CPU Port [CHG-CPU45H] Met(-], Node(-], Unitf-)

= Devicetlet [CHW-DRM21] Meti2]. Node(5). Unii)
Controller Link [C11w/-CLK21] Met[1), NadefZ2). Unit(1]

Select [Connect]

"y
Ty
-.....
"y
L

Select [Compare] (8) Verify the DeviceNet configuration on another remote PLC.
P Use the same procedure as step (2) for Network “N4” to verify the network Structure.
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Saving
System
Config.

Controller
Link
Diagnosis
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Start-Up

DeviceNet
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Start-Up

/F Start-Up

Controller Link Diagnosis

Confirm that the Controller Link connection is correct with an upper level System.
= Diagnosis result check OK

(1) Connectto PLC online, then connect to Controller Link Unit through the online connection
information window.

_I = @, Orline Toolbus EDM1 9600.Mone8,1 [E.J‘IM EPU13] Met(0). Mode(0)

. . . -.f.—SCUP tDJ1 S
RIght-ClICk a DeviceNet o ot | Transfer[Networkto BZ]

Unit under Target Device .........................m

in the online connection Start Data Link

information window, then Start Routing Table

select [Connect] MT Link Tool »
ControII;r Link Tool »

=

(2) Next, select the Controller Link network tool.

_I =™ Online Toolbus COM1,9500 Mone 8.1 [C11M- CF'U‘IS]Net[D] Mode(d)

Y N Rua T arget PLC [C)14-CPU13] Met0] [

i, CPU Port [CJTM-CPUT 3] Net(-), Node[] Urit(-]
DeviceMet [CJ7w- DHM21]Net[2] Node[‘l] Unlt[D]

Controller Link [CI{w-CLE 111 (11 Lirit{1]

= SCU Port [CJT TransFer[Networkto PC] 3

Conneck

Start Diata Link.
Start Routing Table

T Link Tool 3
Contraller Link Tool Ie k Diagnosis

. Controller Link Network Diagnostic Tool - [NodeConfigTemp.crg]
File(F) Wiew(\) PLC(P) Diagnose(D} Mode Status{h) Help(H)

FEIER R

Transmission Path Wifire Type Data Link: _

Baud Rate: 2Mbps Comm. Cycle Time 4.8ms Faolling Mode: Mode2 Starting MNode:

Results Lewvel I MNode | Diagnostic Message |
(&) Information Controller Link Network is correct,

Ready

[Metwork Mode1




Servo/lnverter DeviceNet RS232C
Settings Connection Connection

Starting CX-Drive via DeviceNet

Setup Drives on DeviceNet and start CX-Drive on CX-Integrator window.
An example of 3G3MV-PDRT2 is shown below.

When opening a stored data file after starting the dedicated tool, select [Start
Only]. If [Start with Setting Inherited] is selected, new data is created.

:q, NewProject - CX-Integrator

File Edit Yew Insert Metwork Component Tools Windows Help

=181 x|

DEH SR 2R (oo

[EEES- e =]

e 5 4[2

I XA+ * PN DI RANT |

=E

=% NewProjest
1@ Metworl1[DeviceMet)[#012)

Right-click on 3G3MV-
PDRT2 and select [Start
Special Application]
n.- Project

s = 2l x
Component T_w;a". |
-3 EDS(DeviceNel]” @ 4

53 Vendor Yo,

Select [Start with Setting ., J. (& OMRON Corporation " ¥ 4 |
Inherited] 4

. L
- Communications Adsptel ™ ¥ & | yl

{

CFS EDG[DeviceNet] = Metworkl[D...

#01

Parameter

2 Monitor...

Reset

Maintenance information

Register bo anotiier device 3

Export

o UL
gy,
2 paste

Delete

Ghr{HE
Chri+4

Chanae Mode address
L] ine. Device Comment...
=

%] -3, Oniine Toolbus COM1,19200,Hone, &1 [CJ16-CPU42H] Net(0), Node{0)
A =228 LC [CJ1G-CPU42H] Nel(D) 0]

PU Port [C1G-CPU42H] Netl-), Nodel-), Unitf)

ontraller Link [CI1/-CLE21] Met[1], Nade(8), Unit1]
Devicehst [CIW-DRM21] Met{12), Node(6:3], UnitS)

5% Etheet [CHW-ETN1T] Net{10), Node{1 04], Uni(10]

UL

ATy Resul: el
[Launch related Special Application @ On-line
x|

CX-Drive starts and

— Drive Mame

Inverter property

. |Drive1
settings are shown

BGIMY-AZ004-PRG3Z MW7)
+3GEMY-FDRTZ

—Drive Type ——
| Inverter | |aGEMy o7 ~{_  Settines. II. .

—Connection Type

Settings...
—Comments
Twpe vour own comment in here. ;I
-]
QK I Cancel | Help I

"""=s..,. Select Settings to set
detailed Inverter specifications.

Save data click [ | and save the data.

If more than one drive setting data is edited, drive data is saved by drive type and a total

overview is saved in a work file.



Servo/lnverter DeviceNet RS232C
Settings Connection Connection

Connecting a Servo or Inverter to a Personal Computer Serially.

From the [Start] menu, select [Programs] > [OMRON] > [CX-One] > [CX-Drive] > [CX-Drive] to
start CX-Drive when you connect Servo or Inverter with serial connection to your computer.

Select [File] > [New] to create new data if the drive specifications are known.
If the drive is already connected, select [File] > [Autodetect] to detect the model
and specification of this connected drive.

New Drive x|

— Drive Name
|Drivel

— Drive Tvpe
| Tverter | [acamy o =] Settines.
BGIMV-AZ004-PRGEEZ (VT

Select [Settings] ==..,, .

L]
L]
-.....
il

- LY LT
—Connection Twpe ewg, =

|Direct T Settings...

—Comments

Set Cp.mrn.unication Type your own camment in etwork | o E _—
Specifications river |

Slave Unit Address
QK |

Communications Timeout

7 3
W

Make default |

@ Mumber of retries

OK | Cancel | Help

=

Or, select [File] > [Autodetect] to detect the connected drive specification.

To execute

Autodetect, select T
[Settings] and define e
the Search Conditions | | Drive |Proper| Connection I]escriptﬁ)ﬁ

]
] FIN| o
e

Save data Click H I and save the data.




VR AN F*= ¥ = N

Appendix



1. Personal Computer Requirements

Item

System Requirements (Note 1)

Operating System (OS) Microsoft® Microsoft® Microsoft® Microsoft®
(Note 1) Windows® 98SE Windows® NT Windows® 2000 | Windows® XP
Japanese or English version (Service Pack 6a) (Service Pack 3 or
higher)/
Windows® Me
Main Unit DOS/V (IBM AT compatible) computer with a Pentium Il 333 MHz processor or higher.
Pentium Il 1GHz or higher is recommended.
Memory 256MB or higher required. 512MB or higher is recommended. (Note 2)
Hard drive To install entire CX-One, about 1.8GB or more free space is required.
Display High quality display with SVGA (800 x 600) or higher and 256 colors or more.
CX-Process requires XGA or higher quality display.
Optical drive CD-ROM drive

Communication port

At least 1 RS-232C port (Note 3)

Others

For online user registration via the Internet, you need appropriate hardware such as
modem and Internet access rights.

(Note 1):

About operating System for CX-One:
This product does not run on Microsoft Windows95 or other OS versions other than the specified

System requirements.

If you have such an Operating System on a client computer, you must upgrade the Operating
System before installing this product.
Note that the required System and hard drive capacity depend on the System environment.

(Note 2):

The required memory depends on the CX-One Support Software. See the User’'s manual for details.

(Note 3):

An RS-232C port is required for connection with a PLC using CX-One Support Software. If you only
have USB on your personal computer, use a USB-RS-232C conversion cable (CS1W-CIF31).




2. List of Software to be Installed

CX-One Support Software installed with CX-One is shown below.

CX-One Support | Description Required free | Remarks
Software space on
hard drive

CX-Programmer | Software to create and debug programs for SYSMAC CS/CJ series, C ca. 200MB | If necessary
series, or CVM1/C series.

CX-Integrator Software to start up and configure FA networks such as Controller Link, ca. 210MB
DeviceNet, and CompoWay/F.

CX-Position Software to create and monitor various data for SYSMAC CS/CJ series ca. 20MB
NC Unit.

CX-Motion Software to create various data for MC Unit of SYSMAC CS/CJ series, ca. 45MB
alpha series, and CV series and to create and monitor MC programs.

CX-Motion-NCF | Software to create and monitor various data for SYSMAC CS/CJ series ca. 100MB
NCF Unit.

CX-Motion-MCH | Software to create various data, motion programs and monitor the ca. 60MB
SYSMAC CS/CJ series MCH Unit.

CX-Drive Software to configure and adjust various inverter servo data. ca. 65MB

CX-Designer Software to create screen data for programmable terminal NS series. ca. 660MB

CX-Process Software to create and debug instrument block programs for loop ca. 75MB

Tool control Unit board, process, and loop CPU Unit of SYSMAC CS/CJ
series.

Face P|E_lte Software to automatically generate NS series project files for monitoring ca. 50MB

Auto-Builder for | and tuning of a loop controller.

CX-Protocol Software to create data transmission procedure (protocol) with an ca. 20MB
external universal device that is connected to a serial communications
board/Unit of SYSMAC PLCs.

CX-Profibus Software to configure the PROFIBUS Master. (For European market ca. 30MB
only. Possible to install Windows NT4.0/2000/XP only.) ’

CX-Simulator Software to debug programs for SYSMAC CS/CJ series without the ca. 55MB
CPU Unit by simulating the CPU operation on a personal computer.

CX-Thermo Software to configure and adjust parameters for devices (Components ca. 45MB
such as temperature controller).
(Possible to install Windows 2000/XP only.)

CX-FLnet Software to configure and monitor the SYSMAC CS/CJ series FLnet ca. 2MB
Unit.

Switch Box Utility software for PLC debugging. Input/output status and current ca. 5MB

Utility values of address can be monitored and modified easily.

TrajeXia Software to configure the TrajeXia controller. ca. 15MB
(For European market only)

CX-Sensor Software to configure and adujest parameter for sensor devices. ca. 35MB
(For European market only)

PLC Support A group of Components that are commonly used by software that ca.280MB Always

Software consists CX-One, such as CX-Programmer and CX-Integrator. installed

CX-Server Middleware required for communications between CX-One Support

Software and OMRON’s Components.

About 1.8GB of free hard drive space is required on your personal computer to install all CX-One Support

Software.

Make sure that sufficient free space is available.




3. Comparison of Functions Between Conventional Support Software and

CX-One (1/2)

Function

Conventional Support Software

CX-One

Handling of CX-Programmer’s I/O Table
window

Only mounted Unit position information

® Shows used position/size only

(only head address and size of used area
in CIO area are displayed)

® Assignment DM setting of CPU Bus
Units and Special I/0 Units is unavailable.

In addition to traditional functions, the
following functions are available:

® Used as a setting terminal of CPU Bus
Units and Special I/0 Units

® Used as a terminal to start each Unit's
Support Software

Initial setting of CPU Bus Units and
Special I/0 Units (assignment DM,
assignment relay, CPU Bus Unit System
setting)

® Configuring four-digit hexadecimal or
other value for each address by referring to
assignment DM area on the manual using
PLC memory as with universal DM area.

® By right-clicking a target Unit on the 1/O
Table and selecting [Unit Setup],
configuration is available of CPU Bus Units
and Special I/0 Units parameter (mainly
allocation DM) setting without referring to a

manual in the foIIowin= dial0= box.
CI1w-CLK21 [Edit Parameters]

[l 3
] 0 ;

| | | |

ST [ s [ala]a] =
o o s o
-
o
=
i |

* |t is necessary to configure values while

checking addresses based on Unit number.

And the data are not saved as parameter
data for each Unit (only as DM data for a
CPU Unit).

Displayed Parameter [Data rk automatic selling [aualy layot) '~

Ttern Setvalue Uriit
Data link mode Wanual seting
/Area 1 data link start word 0
Areat type Areat notused
Number of send words per nods of Are |0
(Area 2 data link start word 0
Area 2type Area 2 notused
Number of send words per node ofAre |0
First data link status word 0

= 4
= o

TowiaPCtoUn | _Copon | hwa |
Set Defaults oK Cancel

* Setting is available using item names
without recognizing addresses. Also, data
can be saved/read as a parameter setting
data file for each Unit.

® Setup data can be handled in the same
way as other I/O memory areas for saving
into a CXP project file or as a data file of
file memory.

@ Setup data can be saved in a parameter
setting data file for each Unit, or into a CXP
project file for entire Units’ parameter settings.

Network | Ethernet |CPU Bus Unit By [Unit Setting] in the online CX- By right-clicking on an Ethernet Unit of the
setting System Setting for | Programmer’s I/O Table. 1/0 Table and selecting [Unit Setup]. Can be
Ethernet Unit saved as a parameter as with other CPU Bus
Units and Special I/0 Units.
Ethernet network No tool for monitoring Ethernet network. Ethernet network connection device can be
monitor monitored by CX-Integrator.
Controller | Controller Link Unit | By right-clicking on a Controller Link Unit of | By right-clicking on an Controller Link Unit of
Link soft-switch setting | the I/O Table in the online CX-Programmer | the I/O Table online or offline and selecting

and selecting [Software Switch Setting].

[Unit Setup].

Controller Link Data
Link (manual or
automatic) setting

By CX-Net (Data Link Component) in CX-
Programmer.

Trough a Data Link Component by selecting
[Tools] > [Start Data Link] from CX-Integrator.

Controller Link
network monitor

No tool for monitoring Controller Link
network.

Controller Link network connection device
can be monitored by CX-Integrator.
Controller Link diagnosis tool can be started
as well (By selecting [Tools] > [Controller
Link Tool] > [Network Diagnosis] from online
CX-Integrator).




3. Comparison of Functions between Conventional Support Software and

CX-One (2/2)

Function Conventional Support Software CX-One
Network | DeviceNet Fixed assignment by | Fixed assignment: No setting tool Fixed assignment: By right-clicking on a
setting DeviceNet, or free (by edit on PLC memory). DeviceNet Unit of the 1/0 Table online or
assignment by Free assignment: By DeviceNet offline and selecting [Unit Setup].
assignment DM. configurator. Free assignment: By right-clicking on a
DeviceNet Unit of the I/O Table through
online or offline CX-Integrator and selecting
[Edit Parameters].
Free assignment By DeviceNet configurator. By right-clicking on a DeviceNet Unit of the
and Slave parameter 1/0 Table and selecting [Start Special
setting/monitoring by Application] for device parameter edit.
DeviceNet
configurator
CompoWay/F | CompoWay/F Slave | By CX-Thermo Temperature controller: By right-clicking on

station parameter
setting

a target Unit through online or offline CX-
Integrator and selecting [Start Special
Application] to start CX-Thermo and edit the
setting.

Smart sensor: By right-clicking on a target
Unit through online or offline CX-Integrator
and selecting [Edit Parameters] to edit.

Routing Table

By CX-Net (Routing Table
Component) in CX-Programmer.

By selecting [Tools] > [Start Routing Table]
from CX-Integrator to use Routing Table
Component.

(Note)

I/O Table can be started from CX-Programmer or CX-Integrator on CX-One.
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